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Course Guide 

Introduction 

CIT705 – Computer Application in Business is a 2 credit unit course  designed  to  train you 

for  the  use  of  personal computer in  the  world of business.  The knowledge gained in this 

course would lead to proficiency in electronic business management.  As a business 

educator in training, it is advised  that  you  study each unit carefully to ensure you gain the 

desired skills required in electronic business management. 

 

Course Competencies 

In this course you will be exposed to the introductory aspect of computers and its 

application in business, the use of Microsoft Word in business, Microsoft Excel in business 

and other computer applications in business. 

 

Course Objectives 

At the end of this course, you should be able to: 

 

 Identify various business documents maximally, 

 Create electronic business documents with minimal errors, 

 Manage business data effectively, and 

 Manage business data efficiently. 

 

Working through this Course 

To gain the maximum proficiency required in this course, you must work through all the 

study units. Starting from module 1, unit 1 to module 4, unit 4.  Ensure you master a unit of 

study before proceeding to the next unit. Where references are made  to  previous taught 

courses or elsewhere, you should Endeavour to visit reference sources. 

 

Study Units 

This course material contains four modules and sixteen study units as follows:  

Module 1 Introduction to Computers and Business 

Unit 1:  History and Generations of Computers 

Unit 2:  Basic Concepts of Computers 

Unit 3:  Importance and Application of Computers in Business 

 

Module 2 Microsoft Word in Business  

Unit 1:  Document Production 

Unit 2:  Data Security 

Unit 3:  File Management 

Unit 4:  Document Presentation,  

 

 

 

 

Module 3 Microsoft Excel in Business 



 

Unit 1:  Solving and Making Decision with Microsoft Excel  

Unit 2:  Managing Large Worksheet 

Unit 3:  Presentation of Data with Charts 

 

Module 4 Other Applications in Business  

Unit 1:  Graphics 

Unit 2:  Database 

Unit 3:  Microsoft Office Outlook 

Unit 4:  Desktop Tools/Data Communication/Creating Website 
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Presentation Schedule 

The Presentation Schedule included in your course material gives you important dates for 

the completion of Tutor Marked Assignments and tutorial attendance.  Remember, you  are 

required to submit all your assignments by the due date. You should guard against falling 

behind in your work. 

 

Assessment 

Your assessment will be based on Tutor Marked Assignments (TMAs) and final 

examination which you will write at the end of the course. 

 

How to get the Most from the Course 

In distance learning, the study units replace the university lectures. This is  one  of the great 

advantages of distance learning; you can read and work through specially designed study 

materials at your own pace, and at a time and place that suits you best.  Think of it  as 

reading the lecture instead of listening to the lecturer. In the same way a  lecturer  might 

give you some reading to do, the study units tell you when to read, and which are your text 

materials or set books. You are provided exercises to do at appropriate points, just as a 

lecturer might give you an in-class exercise. 

 

Each of the study units follows a common format. The first item is an introduction to the 

subject matter of the unit, and how a particular unit is integrated with the other units and the 

course as a whole.  Next to this is a set of learning objectives.  These objectives let you 

know what you should be able to do by the time you have completed the unit. These 

learning objectives are meant to guide your study. The moment a unit is finished, you must 

go back and check whether you have achieved the objectives. If you make this a habit, then 

you will significantly improve your chances of passing the course. The main body of the 

unit guides you through the required reading from other sources. This will usually be either 

from your set books or from a reading section. The following is a practical strategy for 

working through this course. If you run into any trouble, telephone your tutor. Remember 

that your tutor‘s job is to help you. When you need assistance, do not hesitate to call and ask 

your tutor to provide it. 



 

 

In addition, do the following: 

 

1. Read this Course Guide thoroughly, it is your first assignment. 

 

2. Organise a Study Schedule.  Design a ―Course Overview‖ to guide you through   the 

Course. Note the time you are expected to spend on each unit and how the assignments 

relate to the units. Important information, e.g. details of your tutorials, and the date of the 

first day of the semester is available from the study centre. You need to gather all the 

information into one place, such as your diary or a wall calendar. Decide on a method and 

write in your own dates and schedule of work for each unit. 

 

3. Once you have created your own study schedule, do everything to stay faithful to   

it. The major reason students fail is that they get behind with their course work. If you get 

into difficulty with your schedule, please, let your tutor know before it is tool late for help. 

 

4. Turn to Unit 1, and read the introduction and the objectives for the unit. 

 

5. Assemble the study materials. You will need your set books and the unit you are 

studying at any point in time. 

 

6. Work through the unit. As you work through it, you will know what sources to 

consult for further information. 

 

7. Keep in touch with your study centre as up-to-date course information will be 

continuously available there. 

 

8. Well before the relevant due dates (about 4 weeks before due dates), keep in mind 

that you will learn a lot by doing the assignments carefully. They have been designed to 

help you meet the objectives of the course and therefore will help you pass the examination. 

Submit all assignments not later than the due date. 

 

9. Review the objectives for each study unit to confirm that you have achieved them. If 

you fee unsure about any of the objectives, review the study materials or consult your tutor. 

 

10. When you are confident that you have achieved a unit‘s objectives, you can start on 

the next unit. Proceed unit by unit through the course and try to pace your study so that you 

keep yourself on schedule. 

 

11. When you have submitted an assignment to your tutor for marking, do not wait for 

its return before starting on the next unit. Keep to your schedule. When the assignment is 

returned, pay particular attention to your tutor‘s comments, both on the tutor-marked 

assignment form and on the ordinary assignments. 

 



 

12. After completing the last unit, review the course and prepare yourself for the final 

examination. Check that you have achieved the unit objectives (listed at the beginning of 

each unit) and the course objectives (listed in the Course Guide). 

  

13. Finally, ensure that you practice on the personal computer as prescribed to gain the 

maximum proficiency required. 

 

Facilitation 

The dates, times and locations of these Tutorials will be made available to you, together 

with the name, telephone number and address of your Tutor. Each assignment will be 

marked by your tutor. Pay close attention to the comments your tutor might make on  your 

assignments as these will help in your progress. Make sure that assignments reach your tutor 

on or before the due date. 

 

Your tutorials are important; therefore try not to skip any. It is an opportunity to meet your 

tutor and your fellow students. It is also an opportunity to get the help of your tutor and 

discuss any difficulties you might encounter when reading. 



 

Course Information 

Course Code: CIT 705 

Course Title: COMPUTER APPLICATION IN BUSINESS 

Credit Unit: 2 units 

Course Status:  

Course Blurb: This course covers computers and its various applications to business. The 

basic concepts of computers, history and generations of computers are discussed within the 

context of this course. The applications of computers in business are also presented. In this 

course content, the use of Microsoft Word, Excel, Access, Outlook, etc are extensively 

presented. 

Semester: 

Course Duration:  
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Ice Breaker 

Describe yourself in three words 

If you could solve one of the world‘s greatest problems, which one would you choose? 

Where do you want to live after you finish school? Why? 



 

 

 
 

Module 1: INTRODUCTION TO COMPUTERS AND BUSINESS 

 

Module Introduction 

In this module a brief history and overview of computers will be presented. The importance of 

computers to business and the application areas of computers in business are discussed in this 

module. This module is divided into three units. They are:  

Unit 1:   History and Generations of Computers 

Unit 2:   Basic Concepts of Computers 

Unit 3:   Importance and Application of Computers in Business 

 

Unit 1: HISTORY AND GENERATIONS OF COMPUTERS 

 

Contents 

1.0 Introduction 

2.0 Intended Learning Outcomes (ILOs) 

3.0 Main Content 

3.1 Early Counting Devices 

3.1.1 Limitations of the Early Counting Devices 

3.2 Mechanical Counting and Calculating Devices 

3.2.1 The Abacus 

3.2.2 Napier‘s Bone 

3.2.3 Slide Rule 

3.3 Electro-Mechanical Counting Devices 

3.3.1 Blaise Pascal Machine 

3.3.2 Gottfried Leibniz Machine 

3.3.3 Joseph Jacquard Loom 

3.3.4 Charles Babbage Analytical machine 

3.4 Electronic Counting Devices and Modern Computer 

3.4.1 Herman Hollerith Punch Cards 

3.4.2 John Von Neumann Machine 

3.4.3 Modern machines 

4.0 Self-Assessment Exercise(s) 

5.0 Conclusion 

6.0 Summary 

7.0 Further Readings 
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   1.0 Introduction 

Computers truly came into their own as great inventions in the last two decades of the 20th century. 

But their history stretches back more than 2500 years to the abacus: a simple calculator made from 

beads and wires, which is still used in some parts of the world today. The difference between an 

ancient abacus and a modern computer seems vast, but the principle—making repeated calculations 

more quickly than the human brain—is exactly the same. This unit presents the history of 

computers from the early counting devices to modern devices. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 

 identify the various early counting devices, 

 identify the various mechanical and electromechanical counting devices, 

 identify the various electronic counting devices, 

 explain the modern computer 

 

   3.0 Main Content 

3.1  Early Counting Devices 

Early counting devices are devices that were used in the early days to perform arithmetic operations 

such as addition of numbers, subtraction and multiplication. Examples of early counting devices are 

fingers, toes, stones, sticks, pebbles, cowries among others. The history and development of 

computers can be traced back to the studies of Mathematics which started with counting. The 

history of Mathematics is the history of civilization. These has led to various computing inventions 

in search for a tool that could enable man meet his computational and data processing needs until 

we have the computer today. It was in the process of finding solutions to the problem of counting 

that early counting devices emerged. Examples of fingers and toes method of calculation are seen 

below; 

 
Fig 1: Finger method of calculation 

 



 

As time went on, fingers and toes method became ineffective, especially for large numbers, hence, 

the emergence of stones and sticks for counting and solving basic arithmetic problems. 

 

 
Fig 2: Other early method of calculation 

 

3.1.1 Limitations of the Early Counting Devices 

The problems posed by these early counting and data processing method were enormous. The 

following are limitations to the early counting devices: 

1. They could not be used for counting large numbers efficiently and effectively. 

2. It was stressful to use 

3. It required man power 

4. It was time consuming 

5. It required more of that device to perform a large number of counting 

 

3.2 Mechanical Counting and Calculating Devices 

As a result of the disadvantages of the early counting devices, more advanced mechanical counting 

and calculating devices were invented. Some of these devices are; 

1. Abacus (Chinese) 

2. Napier‘s Bone (John Napier) 

3. Slide Rule (William Oughtred) 

  

3.2.1 The Abacus 

The abacus was one of the first adding machines. The abacus is made out of beads strung by several 

wires. The position of a bead determines its value. Thus a few beads are required to represent large 

numbers. 

The abacus (plural abaci or abacuses), also called a counting frame, is a calculating tool that was 

in use in the ancient Near East, Europe, China, and Russia. The exact origin of the abacus is still 

unknown. The Abacus is made up of beads threaded on iron rods. The iron rods are fixed to a 

rectangular wooden frame. It is used for addition and subtraction only. It could not carry out 

https://en.wikipedia.org/wiki/Ancient_Near_East


 

complex mathematics. 

For any particular abacus design, there are usually numerous different methods to perform a certain 

type of calculation, which may include basic operations like addition and multiplication, or even 

more complex ones, such as calculating square roots. Some of these methods may work with non-

natural numbers (numbers such as 1.5 and 
3
⁄4). 

 
Fig 3: The Abacus 

 

3.2.2 Napier’s Bone 

After the Abacus, the next significant development was the Napier‘s Bone made by John Napier in 

the year 1617. John Napier was a mathematician, physicist, and astronomer from Scotland. His 

most important achievement was the discoverery of logarithms. He also made the use of the decimal 

point in arithmetic and mathematics common. Napier‘s bone is a manually-operated calculating 

device for calculation of products and quotients of numbers. 

The method was based on lattice multiplication, and was also called Rabdology. Using the 

multiplication tables embedded in the rods, multiplication can be reduced to addition operations and 

division to subtractions. A more advanced use of the rods was for square roots operations. Napier's 

bones are not the same as logarithms, with which Napier's name is also associated. 

The complete device usually includes a base board with a rim; the user places Napier's rods inside 

the rim to conduct multiplication or division. The board's left edge is divided into 9 squares, holding 

the numbers 1 to 9. The Napier's rods consist of strips of wood, metal or heavy cardboard. Napier's 

bones are three-dimensional, square in cross section, with four different rods engraved on each one. 

A set of such bones might be enclosed in a convenient carrying case. 

A rod's surface comprises 9 squares, and each square, except for the top one, comprises two halves 

divided by a diagonal line. The first square of each rod holds a single digit, and the other squares 

hold this number's double, triple, quadruple, quintuple, and so on until the last square contains nine 

times the number in the top square. The digits of each product are written one to each side of the 

diagonal; numbers less than 10 occupy the lower triangle. 

 

https://en.wikipedia.org/wiki/Square_root
https://en.wikipedia.org/wiki/Natural_number
https://en.wikipedia.org/wiki/Lattice_multiplication
https://en.wikipedia.org/wiki/Square_root
https://en.wikipedia.org/wiki/Logarithm


 

 
Fig 4: The Napier Bone 

 

3.2.3 Slide Rule 

The slide Rule which is also called the slip-stick was invented in1622 shortly after John Napier‘s 

publication of the concept of logarithms. It is a mechanical analogue computer. The slide rule is 

used mostly for multiplication, division, and also for functions as roots, algorithms and 

trigonometry, but is not normally used for addition or subtraction. 

Slide rules come in different range of styles and generally appear in a straight or circular form with 

a standardized set of markings (scales) essential to performing mathematical operations. It was used 

widely for calculations up until the 1970s when the scientific calculator was invented, creating a 

much easier and more convenient way to calculate. 

 

 
Fig 5: The Slide Rule 

 

3.3 Electro-Mechanical Counting Devices 

3.3.1 Blaise Pascal Machine 

In 1642 Blaise Pascal invented the first calculating machine when he was 19 years old. This 

machine was developed to assist his father‘s work as a government auditor of accounts. The 

machine consists of clogged wheels, gears, and dials. Each wheel was divided into ten sections, 

representing numbers (0-9), and the mechanism allowed a carry from one wheel to the next. This 



 

principle is still in use today. Odometers in cars use Pascal‘s wheel principle to keep track of the 

number of kilometers traveled. The machine had input, processing and output devices. Basically, 

the Pascal machine was only capable of addition. 

 

 
Fig 6: Blaise Pascal Machine 

 

3.3.2 Gottfried Leibniz Machine 

A famous German mathematician, Gottfried Von Leibniz made the most significant contribution to 

the mechanical calculator in 1671 when he invented the Leibniz calculating machine. The machine 

can perform 4 arithmetic operations. The machine also used a wheel with teeth on them, termed 

―steeped wheel‖, which allowed long multiplication and division to be done. The process of 

multiplication involved repeated addition. Unfortunately, Leibniz‘s machine was unreliable, as were 

most of the early calculators. Because of this problem, mechanical calculators were not popular for 

many years, and it was not until the late nineteenth century that they became widely used in 

business. 

 

 
Fig 7: Gottfried Leibniz Machine 

 



 

3.3.3 Joseph Jacquard Loom 

The Jacquard loom is a mechanical loom, invented by Joseph Marie Jacquard in 1800. The loom 

simplifies the process of manufacturing textiles with complex patterns such as brocade, damask, and 

matelasse. In 1725, French weaver, Basile Bouchon constructed a weaving loom that could be 

controlled by holes in a roll of paper.  The holes allowed some needles in the loom to be engaged, 

while others were held back. 

The loom was, therefore ―programmed‖ by the placement of the holes in the roll of paper to 

produce a particular pattern. However, in Bouchon‘s loom, someone had to be employed to control 

the needles and decide which would be used for each line of weave in the fabric. 

But Joseph-Marie Jacquard improved upon Bouchon‘s design by developing a loom which used a 

punched card to control each line of the weave.  Over 1000 needles could be controlled at one time, 

and very intricate designs were easily created. 

 

  
Fig 8: Joseph Jacquard Loom 

 

3.3.4 Charles Babbage Analytical machine 

Charles Babbage was a mathematics professor at Trinity College in Cambridge, England.  After 

several unsuccessful attempts at building a mechanical calculating machine, Babbage developed the 

analytical engine in 1834. Babbage‘s designs were similar to the general design of modern-day 

computers, including a central arithmetic unit for calculating, called a mill, an area for retaining 

numbers, called a store, and sophisticated methods for input and output. 

While working on his analytical engine, Babbage began a lengthy correspondence with poet Lord 

Byron‘s daughter, Ada Augusta, Countess of Lovelace. Lady Lovelace became fascinated with 

Babbage‘s ideas, and in her analysis of his analytical engine, she developed the essential ideas of 

programming, such as ―branching‖ to perform decisions and repetitions. Because of her work in this 

area, she is considered to be the first computer programmer. The programming language ―Ada‖ is 

named after her. 



 

 
Fig 9: Charles Babbage Analytical machine 

 

3.4 Electronic Counting Devices and Modern Computer 

3.4.1 Herman Hollerith Punch Cards 

The rest of the nineteenth century witnessed the design of more complicated mechanical devices. 

By 1890, an American called Dr. Herman Hollerith made the most outstanding and important 

invention called punch cards. The machine was used to process information obtained in the census 

of the population carried out in the United States in 1890. With this machine, he was able to achieve 

in three years what will take seven years to do manually. 

Hollerith used Jacquard‘s punched-card idea to feed personal statistics into his machine.  Holes in 

the punched cards stood for a person‘s age, sex, state, and other similar information.  There was one 

card for each person. As each card was fed into the machine, a set of metal pins were brought down 

on the card.  The pins passed through any holes punched in the card, which completed an electrical 

circuit which turned a counter dial. 

To sell the machine, Hollerith formed his own company in 1896, then later merged with several 

other companies to form the Computing Tabulating Recording Company (CTR) in 1911. CTR later 

became the International Business Machines or IBM. 

 

 
Fig 10: Herman Hollerith Punch Cards 

 

3.4.2 John Von Neumann Machine 

In 1945, the Hungarian born American mathematician, John von Neumann undertook a study of 

https://en.wikipedia.org/wiki/Herman_Hollerith
https://en.wikipedia.org/wiki/Herman_Hollerith


 

computation. In this study, he demonstrated that a computer could have a simple, fixed structure, 

yet be able to execute any kind of computation if given properly programmed control, and without 

the need for hardware modification. 

Von Neumann contributed a new understanding of how practical fast computers should be 

organized and built; these ideas, often referred to as the stored-program technique, became 

fundamental for future generations of high-speed digital computers and were universally adopted. 

The principal feature of a von Neumann machine is that the program and any data are both stored 

together, usually in a slow-to-access storage medium such as a hard disk, and transferred as required 

to a faster, and more volatile storage medium (RAM) for execution or processing by a central 

processing unit (CPU). 

Since this is practically how all present-day computers work, Neumann is termed the father of the 

modern computer.  

The term ―von Neumann architecture‖ is rarely used now, but it was a common parlance in the 

computing profession through to the early 1970s. 

 
Fig 11: Von Neumann‘s Architecture 

 

Prior to Neumann‘s idea, programs were viewed as essentially part of the machine, and hence 

different from the data the machine operated on. A common approach was to input the program by 

some physical means, such as wiring a plugboard, and then feeding in the data for the program to 

act upon. 

As a result of Neumann‘s discovery, computing and programming became faster, more flexible, 

and more efficient, with the instructions in subroutines performing far more computational work. 

In 1945, von Neumann proposed the stored program concept in his report on the EDVAC. He did it 

together with computer pioneers, J. Presper Eckert, John Mauchly, Arthur Burks, and Hermann 

Goldstine, who was working on plans for the EDVAC. 

According to the original papers proposing the new architecture, a von Neumann computer has five 

parts: an arithmetic-logic unit, a control unit, a memory, some form of input/output, 

and a bus that provides a data path between these parts. Such a computer operates by performing 

the following sequence of steps: 

1. Fetch the next instruction from memory at the address in the program counter. 

2. Add the length of the instruction to the program counter. 

3. Decode the instruction using the control unit. 



 

4. Go back to step 1. 

Von Neumann computers have some drawbacks. In particular, they carry out instructions one after 

another, in a single linear sequence, and they spend a lot of time moving data to and from the 

memory. This slows the computer. This problem is called the von Neumann bottleneck. 

 

3.4.3 Modern machines 

The EDVAC computer, when it was finally constructed in 1952, followed von Neumann‘s design. 

But the first von Neumann computer to be constructed and operated as the Manchester Mark I. 

Manchester Mark 1 

This machine was designed and built at Manchester University in England. It ran its first program in 

1948. The computer had a 96-word memory and executed an instruction in 1.2 milliseconds. Today, 

the computer you are using is born out of von Neumann‘s idea. 

 

 
4.0 Self-Assessment Exercise(s) 

Answer the following questions: 

1. List the early counting devices and state their limitations 

2. Explain the working principle of the Napier bone, Blaise Pascal and Charles Babbage 

machine 

3. Explain the stored program concept by John Von Neumann  

   5.0 Conclusion 

The history of computers goes way back more than 2500 years to the early counting devices to 

abacus to Blaise Pascal machine to the Charles Babbage machine to Von Neumann‘s machine and 

to the modern day computer. Each of these were stepping stones to the modern computer we have 

today. 

 

    6.0 Summary 

In this unit, you have learnt about the history of computers from the early counting devices to the 

modern computer of today. You have also learnt about the pioneers/individuals who put in effort 

and developed these machines and how the machines were used 

. 
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   1.0 Introduction 

A computer is an electronic device that can accept data, store data and manipulate the data to 

produce information or a result. This unit presents the basic concepts of computers such as the units 

of computers, the configuration (hardware and software) of computers. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 

 identify the various units of the computer, 

 differentiate between RAM and ROM, 

 classify computers according to data representation and size, 

 identify various hardware and software components of the computer 

 

   3.0 Main Content 

3.1 Primary Units of a Computer 

There are three classical units, they are tagged as IPO:  

(1) Input unit, 

(2) Processing unit, 

(3) Output unit.  

 

 
Fig 11:  A diagram showing the three basic units (left-right arrows indicate communication flow) 

 

3.1.1 The Input Unit: 

This is the unit that accepts data, instructions and programs into the computer. It is the avenue 



 

whereby users ―talk‖ to or communicate with the computer system. Examples of input devices are 

keyboard (basic input device for entering characters, numbers etc. into the system), scanner (turning 

hardcopy material like pictures into electronic or softcopy formats), mouse (a pointing device that 

helps in selecting objects on the screen), touch screen, light pen, joystick, disk, and other computers 

through network connection. 

 

3.1.2 The Output Unit: 

This is the unit that makes the information (processed data or the result) available to users. Devices 

in this category may display information on the screen, send output to other computers, display or 

print error messages, send requests or even save information for use. Examples are monitor 

commonly called the screen (Cathode Ray Tube (CRT), Liquid Crystal Display (LCD)), printer (to 

get an output printed on paper (hardcopy)) 

 

3.1.3 The Processing Unit: 

This is the unit where the processing of data is done, where data is manipulated. It is divided into 

three main parts namely: 

a) The control unit 

b) The Arithmetic and Logic Unit (ALU)  

c) The main memory 

• The Control Unit/Processor Unit: Directs and coordinates the flow of instructions and 

activities within the computer system. There is nothing that happens that does not involve 

this unit such as input activity, calculation done by ALU, storage of files onto secondary 

memory, release of output, etc. 

• The Arithmetic and Logic Unit: Here, the arithmetic sub-unit performs arithmetic 

operations like addition, subtraction, multiplication, while the logic sub-unit performs 

comparison operations resulting in true or false outcome.  

• The Main Storage: Here, we have the ROM and the RAM and they are referred to as the 

internal memory.  

• ROM (Read Only Memory). This is where some instructions that are responsible for the 

booting or starting up of the computer system are permanently stored. From the name ―read 

only‖, it means the control unit fetches the first set of already coded instructions from there, 

and uses it to put the computer system in a ready state at every instance when the user 

switches the system. ROM chips are installed by the computer manufacturer and the 

instructions cannot be altered by the user. 

• RAM (Random Access Memory). This is the part of memory where every instruction 

resides during execution or processing. All processing take place with the RAM. The RAM 

is volatile; loses its contents on switching the system off. It is random access memory, the 

data on it wherever located can be accessed in equal amount of time. The size and access 

time of the RAM have a great impact on the overall processing speed of a computer system. 

Auxiliary storage is a secondary memory that is non-volatile, usually larger and cheaper than the 



 

main memory, even though slower.  

 

3.2 Classification of Computers  

3.2.1 Classification of Computers based on Data Representation 

There are three basic types of computers with respect to how data are represented: 

1. Digital Computers 

The word ‗digital‘ as used means whole numbers (discrete); for example the channel selector on the 

television set is a digital device because it restricts you to discrete set channels; (you cannot select 

channel 3.141). 

These computers process data in form of discrete or separate values that is 0,1,2,3 etc by operating 

on it in steps. They cannot work with values in intermediate intervals such as 1
1
/2, 1/3 etc. Digital 

computers are more accurate and more flexible than analog computers because they use the digital 

form of electricity signals. However, it must be noted that input and output information in digital 

compatible computers must be converted to analog form before processing can take place. 

Examples are the IBM and compatible machines, and Mackintoshes.  

 

 

 

 

Fig 12: Data representation for digital computer 

 

2. Analog Computers 

In contrast to digital devices, analog devices have continuous values. An example is the volume 

control of a television that allows continuous adjustment of the volume in one smooth action. 

These computers process data in form of variables, that is, quality that changes every time or 

continuous signals. They are like measuring instruments such as thermometers and voltmeter. They 

are mainly used in scientific and industrial control applications. They are devices that can measure 

the numerically defined variables of an abstract system in terms of some physical quality; examples 

are speedometer of a car and odometer of a pressure gauge. 

 

 

 

 

Fig 13: Data representation for digital computer 

 

3. Hybrid Computers 

These computers process data both in digital and analog forms. Hybrid computer is a digital 

computer that accepts analog signals, converts them to digital and processes them in digital form. 

For example, setting (programming) on a modern day television involves both digital and analog. 

They are special purpose computers that have found much application in control and feedback 



 

processes. An example is a robot used in an industrial environment. First, it allows the process to 

get to a particular temperature (analog); it then does some other processes, which could be digital 

and /or analog. 

 

3.2.2  Classification of Computers Based on Size and Processing Power 

The following are the computer systems available according to their sizes and processing power; 

small, or microcomputers, medium-sized or minicomputers, large or mainframe computers and 

super-large or super computers 

1. MICRO COMPUTERS 

A microcomputer is a computer whose central processing unit (CPU) is based on a microprocessor. 

They use silicon chips and memory chips like ROM and RAM. These are the smallest and 

inexpensive computers. They are also known as micro or PCs (Personal Computers). Micro 

computers can be classified into three units which are desktop, portables (laptops, notebooks) and 

hand-held units. 

• Desktop Unit 

This is the computer unit that can fit on top of a desk. It is the type that is found in homes, offices 

and schools. Examples of this are, IBM PC; IBM PA/1, IBM PS/2, Apple II, IIc, and IIe. Desktop 

unit is divided into two, namely: the single user unit or multi-user unit. 

Single User Unit: This is a computer unit that can only be used by one person at a time. 

Multi-user Unit: It is a computer unit that many people can use simultaneously, with two or more 

access points. 

• Portable/Laptop Units 

These are computer units that can fit unto the lap or small enough to be carried in a briefcase. They 

have liquid crystal display (LCD) screen and compact arrangement of keys on the keyboard. They 

are as powerful as the desktop units but more expensive. For their mobility, some are also known as 

notebook computers. 

• Hand-held or Palm top Units 

These are smaller computer units that are usually used to keep track of events, anniversaries, 

translation of words into foreign languages, providing synonyms and antonyms for words and so on. 

They can fit into a pocket; they look like calculators and are operated on top of the palm, (e.g. 

organizers). 

 

2. Mini Computers 

These are computer systems that fall between microcomputers and mainframe computers. They are 

sometimes called minis. They are more expensive than the microcomputers and are used by medium 

sized companies whose volume of work needed computer systems with a higher processing power 

than the microcomputers. Examples are MIR 9300, DEL, HEWLET PACKARD 3000, IBM system 

38 and MU 400 (data general). They are multi-user systems and are usually found in factories and 

warehouses where they are used for managing production and inventory operations. 

 



 

3. Mainframe Computers 

These are large computer systems that are used by big organisations for processing their business 

transactions like payroll, salary, inventory and routine paperwork. They can operate 24 hours a day 

serving hundred of users (e.g. IBM 360/370 system, NCRV-8800 systems). 

 

4. Super Computers 

These are the fastest largest and most expensive computer system. They are used usually in 

scientific and research laboratories. They are also used for crunching of data needed in sending 

astronauts into the outer space, for weather forecasting and in computer generated movies and 

commercials (e.g. CRAY, X-Map and CRAY 2). 

 

3.3 Computer Configuration 

There are two basic components of a computer system: Hardware and Software. 

• The Hardware are the various physical components of a computer system. Any part that can 

be held or felt or touched is hardware. 

• The Software consists of the non-tangible elements. It includes instructions and other 

commands that control the operation of the computer system. 

 
Fig 14: Configuration of a Desktop Computer 

 

3.3.1 The Hardware Component 

The hardware consists of the system unit and peripherals.  

 



 

3.3.1.1 The component of the system unit 

The system units consist of the CPU (e.g. microprocessor), main memory, internal secondary 

memory and other internal components held and made to function together by the  mother-board.  

• The microprocessor: this is the integrated circuit built on a small piece of silicon. This is 

commonly referred to as the brain of the computer system (e.g. Intel family, Motorola etc). 

• The motherboard: It is a large board containing a number of tiny electronic circuits and 

other components. The internal components sit on the board and are linked together by the 

board. Examples of such components are microprocessor, RAM, and ROM. 

• Secondary memory: this is also referred to as the auxiliary storage or the backing storage. 

Since RAM is volatile and may not be able to hold large volume of data or programs, the 

secondary memory provides the necessary support. Anytime a program is needed to run, the 

system moves it from its resting state in the secondary to the primary storage (RAM). We 

can describe this occurrence as reading of files into main storage in manageable form. When 

data is saved on the secondary memory it is kept permanently until it is no longer needed 

and is deliberately erased. Such files can be lost if and only if the disk in damaged or the 

user unconsciously deletes them. Examples of secondary memory includes; hard disk drive 

(fixed disk), floppy disk (diskette), flash drive, zip disk and so on. Only the internally 

attached secondary storage qualifies as part of the system unit. 

 

3.3.1.2 Peripherals  

Peripheral devices are the hardware components of a computer system that are either attached or 

connected externally to the system unit through a wired or wireless media. The common ones are 

input, output, and storage devices. 

•  Input Devices: Used by computer system user to input data and instructions. Examples are: 

– Keyboard: used for entering characters like numeric alphabetic and special 

characters/symbols. 

– Mouse: used as a pointing device to select objects on the screen, place the cursor 

wherever the user wants and so on. 

– Scanner: reads images, converts hard copy material into its electronic form 

– Others are light pen, joystick, digitizing pen, voice recorder etc. 

• The Output Devices: These are means of outputting computer system‘s processing results. 

Examples are: 

• Monitor: Also called Visual Display Unit (VDU) or the screen It gives an instant feedback 

and /or output while working on the system. We have the monochrome type i.e the black 

and white and the colour type i.e. the ones that displays colour and graphics eg. Super Video 

Graphic, Adaptive (SVGA), Video Graphic Adaptor (VGA), Enhanced Graphic Adaptor 

(EGA), etc. 

• Printer: Used to produce computer systems output on paper.  



 

• External Storage: refers to storage/memory like flash disk, hard disk, magnetic tape, 

cassette tape and so on; that are either attached or connected to the system unit mentioned 

earlier. They are secondary storage. 

 

3.3.2 Computer System Software 

Software is the intangible part of a computer system. It is a set of instructions written by a computer 

expert or a programmer that represents the logical steps the computer follows to solve a particular 

problem or do a specific task, and the accessory data. 

Classification of Computer Software 

The different types of computer software available in the global computer market consist of the 

following two main types: (i) Systems Software (ii) Applications Software 

 

3.3.2.1 Systems software  

System software is a program or collection of programs which links other software like the 

application software with the system hardware. It acts like the intermediary between them. These 

are designed or written by software manufacturers and other computer software experts. 

The major system software is the operating systems. Other includes translators and utilities.  

 

Operating Systems: a software designed by system developers to control and manage the resources 

of a computer system. Examples of such resources are the hardware resources such as (memory, 

other peripherals), and the software resources like application programs. Management of resource 

by the operating system includes memory management, sharing of resources, error handling, 

running of other programs, interrupt handling etc. or graphics application. 

 The operating system acts as an interface, or link, between the user and the computer hardware.  

 
Fig 15: The operating system acts as interface between the computer hardware and the user 

 

Utility Software: Utility software performs the basic operations necessary for the fundamental 

performance of the computer system such as creating, copying, saving, deleting, merging and 

sorting files. 

 

Language Translators: Language translators convert programmers-made instructions into 

machine-language instructions (object code). Types of language translators are: 

i. Assemblers 



 

ii.  Interpreters 

iii.  Compilers 

(i) Compiler: Compiler is a language translator which is used to convert programs written in High-

Level Language all at once to low-level language. It translates the entire program and also reports 

the errors in source program encountered during the translation. 

(ii) Interpreter: Interpreter is a language translator which is used to convert programs in high-level 

language to low-level language. Interpreter translates the program line by line and reports the error 

once it encountered during the translation process. 

(iii) Assemblers: Assembler is a language translator which is used to translate a program written in 

Assembly language to machine language code. 

 

3.3.2.2 Applications Software 

There are two main types of Application software:  Off the shelf/General purpose and In-

house/User Defined. 

•  General Purpose/Off the Shelf Application Software 

As the name implies, these are the programs designed by computer experts to be applied or used in 

solving a particular type of problem. They are usually general purpose software which may be 

useful to many organisations at the same time. The designer and developers consider the need of the 

general public in a particular problem area and produce a program that will meet the general needs.  

Examples are: word processing packages (e.g MS word), spreadsheet packages (e.g MS Excel), 

communication software (e.g Internet explorer), analytical/statistical packages (e.g SPSS) 

 

• User-defined/In-house Application Software: 

 This refers to the custom-built program or software written by a programmer or group(s) of 

them (employed to do so) to meet the need of a particular user or customer. Program developers or 

software experts would have to visit the individual in need of this, ask for his 

requirement/specification, do appropriate feasibility study, do analysis, put up a design and finally 

come up with a program that meets these very needs. Because it is not a generalised software like 

the general purpose application software (e.g. MS Word), the program tends to cater for all that the 

customer wants. A good example of this kind of software is the University Result Processing 

Software that caters for the students‘ record and their Cumulative Grade Point Average (CGPA). 

 

The following list describes different kinds of software applications that would be suitable for 

different tasks: 

• Word Processing software - Use this kind of tool to create worksheets, type letters, type 

papers, etc. MS Word, WordPerfect, MS Works, AppleWorks, .... 

• Desktop Publishing software - Use this software to make signs, banners, greeting cards, 

illustrative worksheets, newsletters, etc. Adobe PageMaker, MS Word, MS Publisher, 

AppleWorks, MS Works, Quark Express,.. 



 

• Spreadsheet software - Use this kind of tool to compute number-intensive problems such 

as budgeting, forecasting, etc. A spreadsheet will plot nice graphs very easily. MS Excel, 

Quattro Pro, Lotus 1-2-3,  .... 

• Database software - Use this software to store data such as address, membership and other 

text information. A database can be used to easily sort and organize records. MS Access, 

Filemaker Pro, ... 

• Presentation software - Use this software to create multimedia stacks of cards/screens that 

can effectively present a lesson or a sales pitch. The user often clicks on buttons to advance 

to the next screen in a sequence.MS PowerPoint, AppleWorks (slideshows), HyperStudio, 

Flash, Director, HyperCard, Digital Chisel, SuperCard, Corel Envoy,... 

• Internet Browsers - This software allows one to surf the Web. Often they can read email 

and create Web pages too. Netscape Navigator (or Netscape Communicator), MS Internet 

Explorer, Mozilla Firefox, Opera…. 

• Email programs - These programs send and receive email. Netscape Messenger (part of 

Netscape Communicator), MS Outlook Express, MS Outlook, Eudora, AOL browser (has 

email built in).... 

• Graphics Programs (pixel-based) - This software allows one to touch up photographs and 

create graphics from scratch. Adobe Photoshop, Paint Shop Pro, MS Paint (comes free on 

Windows PC's), Adobe Illustrator, Corel Draw, Painter, .... 

• Communications software - This software allows two computers with modems to 

communicate through audio, video, and/or chat-based means.MS NetMeeting, AOL Instant 

Messenger, IRC, ICQ, CU-See Me, ... 

 

 

4.0  Self-Assessment Exercise(s) 

Answer the following questions: 

1. List and explain the primary units of a computer 

2. Classify computers according to data representation and size, 

3. identify various hardware and software components of the computer 

4. Differentiate between General purpose and User defined application software 

 

   5.0 Conclusion 

A computer is an electronic device that can accept data, store data and manipulate the data to 

produce information or a result. The computer is divided into three main units which are the (i) 

Input Unit (ii) Processing Unit (iii) Output Unit. Computers can also be classified based on the 

type if data represented and the size and processing power of the system. There are two main 

configurations that make up the computer system: (i) hardware components (ii) software 

components. 



 

    6.0 Summary 

In this unit, you have learnt about the following: 

 The three (3) primary units of the computer system, 

 Classification of computers according to data representation and size, 

 Hardware and software components of the computer 
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   1.0 Introduction 

Over the years, computers have become of great importance and applied in virtually every aspect 

such as aviation, education, business, finance, etc. In this unit the focus will be on business, that is, 

the importance and application of computers in business.  

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 

 identify the importance of computers in business, 

 identify and explain various application areas of computers in business, 

 

   3.0 Main Content 

3.1 Importance of Computers in Business 

The following are the importance of computers in business 



 

 A computer is important to use in business to automate the manufacturing, marketing and, 

distribution process. It is the 1st and main tool in business that generates and manages 

profits. 

 Computers help in research, production, distribution, marketing, banking, team 

management, business automation, data storage, employees management and very helpful to 

increase the productivity in lower cost, less time with high quality.  

 Computer help business to manage, calculate, arrange, and visualize customer data and 

information by us computer applications such as Microsoft word, excel, lower power point 

and tally etc..  

 A computer helps to communicate faster with the customer by using the internet, online 

communication tools and internet phone system. It‘s really important for the administration 

of the big or small organization and each field that manage resources and opportunities. 

 Computer help creates marketing and advertising materials by using adobe Photoshop, Corel 

draw, online designing tools.  Also to create websites for the business 

 The computer is important in business to automate business transactions by using online 

banking, payment Gateway. 

 

3.2 Application Areas of Computers in Business 

The following are some of the application areas of computers in business: (i) Business 

Communication (ii) Inventory Management (iii) Customer Relationship Management (iv) Payroll 

(v) Advertisement (vi) Data Management and Analysis (vii) Management Information System (viii) 

Human Resource Management 

 

3.2.1 Business Communication 

This is the sharing of information between people within an enterprise that is performed for the 

commercial benefit of the organization. In addition, business communication can also refer to how a 

company shares information to promote its product or services to potential consumers. 

Business communication within an organization can either be: 

Upward communication: any communication that comes from a subordinate to a manager or from 

another person up the organizational hierarchy. 

Downward communication/Managerial communication: anything that comes from a superior to 

a subordinate. 

Lateral communication/ Technical communication: internal or cross-departmental 

communication between coworkers 

 

Methods of business communication include: 

Web-based communication: This includes everyday communication channels like emails and 

instant messaging applications (such as Slack, Hangouts, or even Nextiva Chat). The benefits of 

emails and messages lie in the ability to lead private conversations in a busy office environment, as 

well as sharing a message with many people—from a few to hundreds—all at once. 



 

Telephone meetings: Phones removed the location barrier to running productive, fast-moving 

meetings. It allows for better idea exchange thanks to the non-verbal communication (tone of voice) 

compared to written communication. Cloud phone systems can accelerate onboarding and overall 

team collaboration. 

Video conferencing: Great video conferencing systems enable people at remote locations to run 

meetings that feel as close to in-person meetings as possible. They take phone meetings one step up. 

Face-to-face meetings: In-person meetings can help a business move forward with ideas quickly. 

Research shows that in-person meetings generate more ideas than virtual meetings. However, 

having a rock-solid meeting agenda is essential for effective meetings. 46% of employees rarely or 

never leave a meeting knowing what they‘re supposed to do next. 

Reports and official documents: Documenting activities that impact other people and departments 

is a crucial part of a well-oiled business communication system. The ability to refer to a written 

document at any moment reduces the chance for confusion or disagreement and provides extra 

clarity in communication. 

Presentations: Presentations supported by reports and PowerPoint slide decks are often how 

meetings with larger groups are conducted. These are great for sharing new ideas in a way that 

creates space for questions and any clarifications. 

Forum boards and FAQs: An internal area for employees to refer to frequently asked questions on 

various departmental topics and to ask new ones that will make them more productive and up-to-

date on a matter. 

Surveys: Both internal and customer surveys are an ideal way to gather feedback and ratings on 

important topics. Surveys facilitate a healthy cycle of feedback-supported improvements and open a 

communication channel between all levels inside an organization. 

Customer management activities: This can include any customer relations activity. Examples 

include live chat support, customer relationship management (CRM) systems, customer onboarding 

process, customer reviews, and more. 

Suggestion box: primarily for upward communication, because some people may hesitate to 

communicate with management directly, so they can give suggestions by drafting one and putting it 

in the suggestion box. 

 

3.2.2 Inventory Management 

Inventory management is the supervision of non-capitalized assets (inventory) and stock items.  

A component of supply chain management, inventory management supervises the flow of goods 

from manufacturers to warehouses and from these facilities to point of sale. A key function of 

inventory management is to keep a detailed record of each new or returned product as it enters or 

leaves a warehouse or point of sale.  



 

 
Fig 16: Inventory Management 

 

Inventory management uses a variety of data to keep track of the goods as they move through the 

process, including lot numbers, serial numbers, cost of goods, quantity of goods and the dates when 

they move through the process. Computers help in making the process of inventory management 

easier through the use of inventory management software systems 

An inventory management system is a combination of technology (hardware and software) and 

processes and procedures that oversee the monitoring and maintenance of products stocked by a 

company. These products can be either company assets, raw materials, or finished products that are 

ready to be sent to vendors or end consumers. 

 

3.2.3 Customer Relationship Management (CRM) 

Customer relationship management (CRM) is the combination of practices, strategies and 

technologies that companies use to manage and analyze customer interactions and data throughout 

the customer lifecycle, with the goal of improving customer service relationships and assisting in 

customer retention and driving sales growth.  

The use of CRM software systems has helped the CRM approach. CRM systems compile customer 

data across different channels, or points of contact between the customer and the company, which 

could include the company's website, telephone, live chat, direct mail, marketing materials 

and social media. Through the CRM approach and the systems used to facilitate it, businesses learn 

more about their target audiences and how to best cater to their needs. 

 

3.2.4 Payroll 

Payroll is the process by which employers pay an employee for the work they have completed. Any 

business with employees should have a payroll process established; payroll is often the largest 

expense for a business. An effective and efficient payroll process will ensure that employees are 

paid accurately and consistently, keeping them satisfied with this aspect of employment and 

allowing HR to focus on other areas. 

A payroll system is software designed to organize all the tasks of employee payment and the filing 

of employee taxes. These tasks can include keeping track of hours, calculating wages, withholding 



 

taxes and deductions, printing and delivering checks, completing direct deposit, paying premiums to 

insurance carriers, and paying employment taxes to the government. 

Payroll software often requires very little input from the employer. The employer is required to 

input employee wage information and hours—then the software uses the information to perform 

calculations and deduct withholdings automatically. Most payroll software is automatically updated 

whenever a tax law changes and will remind employers when to file various tax forms. 

 

3.2.5 Advertisement 

Advertising is the attempt to influence the buying behavior of customers or clients with a persuasive 

selling message about products and/or services. In business, the goal of advertising is to attract new 

customers by defining the target market and reaching out to them with an effective ad campaign. 

 

3.2.6 Data Management and Analysis 

Data management is an administrative process that includes acquiring, validating, storing, 

protecting, and processing required data to ensure the accessibility, reliability, and timeliness of the 

data for its users. Organizations and enterprises are making use of Big Data more than ever before 

to inform business decisions and gain deep insights into customer behavior, trends, and 

opportunities for creating extraordinary customer experiences. 

To make sense of the vast quantities of data that enterprises are gathering, analyzing, and storing 

today, companies turn to data management solutions and platforms. Data management solutions 

make processing, validation, and other essential functions simpler and less time-intensive. 

Data analysis is a process of inspecting, cleansing, transforming, and modeling data with the goal 

of discovering useful information, informing conclusions, and supporting decision-making. In 

today's business, data analysis is playing a role in making decisions more scientific and helping the 

business achieve effective operation. 

 

3.2.7 Management Information System 

A management information system (MIS) is a computerized database of financial information 

organized and programmed in such a way that it produces regular reports on operations for every 

level of management in a company. It is usually also possible to obtain special reports from the 

system easily. The main purpose of the MIS is to give managers feedback about their own 

performance; top management can monitor the company as a whole. Information displayed by the 

MIS typically shows "actual" data over against "planned" results and results from a year before; 

thus it measures progress against goals. The MIS receives data from company units and functions. 

Some of the data are collected automatically from computer-linked check-out counters; others are 

keyed in at periodic intervals. Routine reports are preprogrammed and run at intervals or on demand 

while others are obtained using built-in query languages 

 

3.2.8 Human Resource Management 

The process of defining HRM leads us to two different definitions. The first definition of HRM is 

that it is the process of managing people in organizations in a structured and thorough manner. This 

covers the fields of staffing (hiring people), retention of people, pay and perks setting and 

https://en.wikipedia.org/wiki/Data_cleansing
https://en.wikipedia.org/wiki/Data_transformation
https://en.wikipedia.org/wiki/Data_modeling
https://en.wikipedia.org/wiki/Data


 

management, performance management, change management and taking care of exits from the 

company to round off the activities. 

The second definition of HRM encompasses the management of people in organizations from a 

macro perspective i.e. managing people in the form of a collective relationship between 

management and employees. This approach focuses on the objectives and outcomes of the HRM 

function. What this means is that the HR function in contemporary organizations is concerned with 

the notions of people enabling, people development and a focus on making the ―employment 

relationship‖ fulfilling for both the management and employees. 

 

  Case Studies 

California Pizza controls costs with IT 

California Pizza Kitchen (CPK) started out in 1985 as a venture by two former federal 

prosecutors who wanted to do something different. They decided to sell "designer pizza" in 

which the pizza dough is a "canvas" for exotic food toppings such as Thai chicken, shrimp pesto, 

Peking duck, or southwestern burritos. By offering stylish entrees costing less than $10 in a sitdown 

setting, CPK mushroomed into a national chain of 70 restaurants in only nine years, with 

PepsiCo buying half-ownership in 1992. 

Success did not come easily to this Los Angeles-headquartered chain. The restaurant business is 

a high-risk industry with many factors that are beyond their control-like :swelling competition, 

fickle customer tastes, and rising real estate costs. Thus, restaurants need to tightly control food 

and labor costs to remain profitable-without affecting the quality of their food or service. 

CPK company is poised for another take-off. It hopes to expand to 700 restaurants by using 

information systems to control food costs and make employees more productive. Since diners 

are turned away by high prices, the only way to control costs is through inventory and portion 

control -keeping precise track of the amount of ingredients used in each menu item and stocking 

only as much of these ingredients as each restaurant actually needs.  

All California Pizza Kitchen restaurants installed point-of-sale (POS) devices, which capture 

data about each item sold at the time the sale takes place. The sales data and inventory reports 

prepared by restaurant managers are transmitted from each restaurant to the company's central 

computer, where the information is consolidated and analyzed. An application called Inventory 

Express "remembers" ordering patterns, such as the amount of lettuce a restaurant needs each 

week, and also compares the amount of each item used to what each restaurant actually sold. If, 

for example, a restaurant sold 100 Thai shrimp pizzas in one week, it should have used a 

predetermined amount of shrimp, such as 40 pounds, based on portion measurements established 

by CPK management. 

Using more shrimp would indicate a problem with over portioning or waste. Restaurants with 

out-of-line portions would be told to take corrective action. The POS-derived data is used for 

other purposes besides portion control. CPK's restaurant operations group uses the data to 

determine peak sales at each location so that they can schedule employee work shifts. The data 



 

tell food and beverage specialists how well each item sells. CPK found that it should get rid of its 

egg-salad pizza, for instance, when the item registered poor sales. California Pizza now has pilot 

projects to move to more state-of-the art information system technology. Waiters and waitresses 

are experimenting with hand-held point-of-sale devices, which management hopes will boost 

productivity by reducing the amount of time employees spend with customers. 

The devices use radio frequencies to transmit orders to a computer in the back of the restaurant, 

eliminating the need for employees to run back and forth to a stationary POS device to place 

orders. CPK can also use its information systems to calculate the relative costs of different 

markets so it can determine if it has a lower profit margin on Hawaiian pizza in Maryland, than 

in Waikiki. (Pineapple should be less expensive in Hawaii than in the northeastern United 

States.) CPK's corporate accounting department can use the aggregated sales data to tally 

revenue and can manage the accounts payable and accounts receivable processes by combining 

that data with financial data residing on a central CPK computer. 

 

 

 

4.0 Self-Assessment Exercise(s) 

Answer the following questions: 

1. State the importance of computers in business 

2. Identify various application areas of computers in business 

   5.0 Conclusion 

The use of computers in business and other areas cannot be over emphasized. New technologies, 

software, applications are developed daily to aid business growth and developemt and to also 

maximize profit. 

 

    6.0 Summary 

In this unit, you have learnt about the following: 

 The importance of computers in business, 

 The various application areas of computers in business. 

 

   7.0  Further Readings 

 

Buttle, F. (2015). Customer Relationship Management. London: Taylor and Francis. 

General introduction to Computing, The Department of Computer Science and Mathematics,  

Babcock University, Ilisan Remo, Ogun State, Nigeria 



 

Hartley, P., & Bruckmann, C. (2015). Business Communication. London: Taylor and Francis. 

Introduction to Business Communications | Boundless Business. (2020). Retrieved 11 August 2020, 

from https://courses.lumenlearning.com/boundless-business/chapter/introduction-to-business-

communications/ 

Kumar, V., & Reinartz, W. (2012). Customer Relationship Management (3rd ed.). Berlin: Springer 

Berlin. 

Parameswaran, R. (2010). Computer Application in Business. Ram Nagar, New Delhi: S Chand & 

Co Ltd. 

Reed, D. (2011). A balanced introduction to computer science (3rd ed.). Pearson. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 
 

Module 2: MICROSOFT WORD IN BUSINESS 

 

Module Introduction 

Microsoft Word is an application software designed to handle the basic skills of business 

documents. The main features of this software are improvement on the use of the typewriting skills 

in typing basic business documents. This module will expose you to the management of business 

documents which will acquaint you on:  

 

Unit 1: Document Production 

Unit 2: Data Security 

Unit 3: File Management 

Unit 4: Document Presentation 

 

Unit 1: Document Production 

 

Contents 

1.0 Introduction 

2.0 Intended Learning Outcomes (ILOs) 

3.0 Main Content 

3.1 Letters 

3.2 Memorandum 

3.3 Reports 

3.4 Minutes 

3.5 Invoice 

3.6 Newsletters/Flyers 

3.7 Tables 

3.8 Charts and Diagrams 

4.0 Self-Assessment Exercise(s) 

5.0 Conclusion 

6.0 Summary 

Comment [D4]: Updated the use of 
Microsoft word 2007 to 2010/2013 and 
windows xp/7 to windows 10.  
Improved on the references and further 
readings. Expunged the very old 
references and incorporated recent 
references and books for further 
readings. 



 

7.0 Further Readings 

 

 

 

 

   1.0 Introduction 

No business can thrive well without data or information which is usually passed from one person to 

another or from one company to another. The life wire of any company lies in the way and manner 

information is being processed and transferred. This makes communication imperative in business. 

There will be no buying, selling or rendering of services if there is no communication. In 

communication, there must be a sender, process and the receiver. There is no communication if the  

receiver cannot decode (interpret)  what has been sent. 

 

 

 

 

Fig 17: Communication in diverse forms 

 

All forms of communication are important in business, but this course material would concentrate 

on written communication; which mostly requires the use of personal computer. Written 

communication in business can take the form of letters, memoranda, reports, minutes, invoice, 

newsletters, flyers, table, charts and diagrams. These are the various forms through which messages 

can be sent from one source to another. The way these documents are presented speaks about a 



 

company‘s image. This is why this unit is designed to teach you the vital skills required when using 

personal computer for business documentation. 

 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Identify different types of business documents; 

 Display business document using the appropriate skills. 

 

   3.0 Main Content 

The most commonly used business documents are: 

 Letters; 

 Memoranda; 

 Reports; 

 Minutes; 

 Invoice; 

 Newsletters and 

 Flyers. 

 

In the process of producing these documents other functions may be required. For example there 

might be need to create a table, use charts and diagrams for illustrations. In this instance it becomes 

necessary to know how personal computer can be used to create these documents. 

 

3.1 Letters 

There are four types of letters. They are: 

i. business letters 

ii. circular letters 

iii. personal-business letters 

iv. personal letters 

We would start the discussion from the bottom. 

 

Personal Letters – These are letters written or received from relatives and friends. This type of 

letter can take any form of display. We are not usually concerned about this type of letter in 

business. Personal letters are not regarded as official letters, hence the name personal letters. 

 

Personal–business Letters – These are personalised letters that take some features of business 

letters. The major difference between personal-business letters and business letters is in the 



 

salutation and complimentary close.  For a business letter the salutation and complimentary close 

are formal. For the salutation, it is usually typed as Dear Sir/ Dear Madam/Sir/Madam and the 

complimentary close is ―Yours faithfully‖. But for personal-business letters, the salutation reflects 

the addressee‘s name e.g. Dear Mr. Adegbuyi/Dear Kayode, while the complimentary close ends 

with ―Yours sincerely‖. Using this form of letter implies that the writer is familiar with the 

addressee. The issue for discussion or the issue for which messages are sent will be a familiar one. 

This method is useful at a certain stage in business, because it makes you have a personal touch 

with your clients. You speak to them in familiar terms; which makes the clients  feel recognised and 

happy. 

 

Circular Letters – These are letters addressed to a group of persons. For example, if a company 

XYZ wants to inform its customers about a change in the company‘s closing hour; the salutation 

would read – Dear Customers. This is to say that the content of the letter is for all the company‘s 

customers. This form of letter is also used by government parastatals when instructing the various 

bodies on actions that should be taken. This form of letter is not specific neither does it consider the 

interest of an individual. 

 

The most important thing to note is that circular letters do not have addressee‘s address, the 

salutation is general, the complimentary close is ―Yours sincerely‖ and sometimes omitted, finally 

the designation is general e.g. Management. The use of complimentary close in circular letters has 

given way to the non-use of it in Nigeria. Most companies have now adopted the non-use of 

complimentary close. Rather simply type Management. 

 

Business Letters – First and foremost we need to look at the different parts of a business letter.   

Just as human beings have parts of the body; which is needed for a whole being    to function, so 

also are the various parts of a business letter, so as to have a standard and presentable business 

letters. 

 

Parts of a Business Letter 

The parts of a business letter are: 

1. Writer‘s Address 

2. References – Our Reference and Your Reference 

3. Date 

4. Attention Line 

5. Addressee‘s Address 

6. Salutation 

7. Heading 

8. Body of the Letter 

9. Complimentary Close 

10. Signature 



 

National Open University of 
Nigeria University Village 
Plot 91, Cadastral Zone 

Nnamdi Azikiwe 
Expressway Jabi, Abuja 

11. Designation 

12. Enclosure. 

 

Although our concern is on the display of a business letter and not the construction or the 

grammatical structure, the various parts of a business letter would be better understood if they are 

discussed. Therefore, let us look at the discussion of the various parts. 

 

Writer’s Address 

The first thing to be seen on a business letter is the writer‘s address. There is a need for the recipient 

(the person to whom the letter is written) to know where the letter is coming from. The practice 

today, is to print the address of the writer at the top edge of the paper. Once this is done, it is 

referred to as letter headed paper. 

There are different qualities of papers that may be used. The printer can give a better advice on this. 

Where there are no printed letter headed papers, the address can be typed  in thus: 

 

 

To achieve the above you need to consider the following: 

1. Set half an inch as top margin 

2. Set your left and right hand margins at 1 inch each or 1
1
/2 inch each 

3. Type in the address, break the words appropriately 

4. Highlight each line and select appropriate font type and size to match a letter headed paper. 

It is not compulsory that all lines of the heading must be equal font size. You can vary the 

size for space or for appropriate display. 

5. Centre each line vertically on the paper. 

6. You may use colour if desired, but with appropriate combinations to reflect the maturity of 

the company. 

 

You may also decide to use the WordArts. Follow this procedure: 

 

1. Click on Insert, the following display will appear at the menu 

 



 

2. Then click on WordArt - , the following drop down menu will appear thus: 

 
3. Click on any design of your choice. A dialog box will appear 

 
 

 

4. Type in the text in the specified box 

5. Follow the command to achieve the desired goal. 

The beauty of the use of word arts is that you can have variety of display. Also you can move the 

text as desired by clicking on the text and move to desired position.  But the best is to use printed 

letter headed paper on a quality A4 paper. 

 

References 

You have two types of references – ―Our Reference‖ and ―Your Reference‖. Reference helps to 

establish relationship between the writer and the receiver; which helps to keep track of the 

communication between the two. ―Our Reference‖ indicates the reference of the writer; which is 

used to keep record of its communication to the receiver.  Then ―Your Reference‖ indicates the 

receiver‘s reference; which is also used to keep record of its communication to the writer. For 

example if company ABC is writing a letter to company XYZ, company ABC reference will be 

―Our Reference‖ and company XYZ reference will be ―Your Reference‖. But if the writing is on its 

first instance, it would be only ABC reference i.e. ―Our Reference‖ that would be available  while  

―Your Reference‖ would be vacant. 

 

Example 

Our Reference: NOUN/REG/CONT/XYZ/1  

Your Reference:   _______________ 

This  takes  us  to  how  to formulate references. The purpose of reference as earlier 



 

Your Ref: Our Ref: 

Show letter headed with reference 
positions 

mentioned is to track communication. So in formulating references you need to consider the 

parameters (tools) involved in tracking the communication. This may involve the names of the 

company, the department the letter is coming from, the purpose of the letter, the volume if 

necessary and the number. With the example above, NOUN refers to National Open University of 

Nigeria; REG refers to Registrar which indicates registrar‘s office; CONT refers to Contractor 

which implies that the subject matter is on contract for company XYZ and the ‗1‘ means that is the 

first letter coming from company ABC to company XYZ. Whoever that is writing takes the position 

of ―Our Reference‖. 

 

It is often advised that the references positions are printed along side with the letter headed paper, 

e.g. 

 

 

Another important thing to note in typing references on a letter headed paper with references 

positions is to ensure alignment i.e. the references should align with ―Our Ref‖ and ―Your Ref‖. To 

do this effectively, requires a ruler. Both the manual and computer rulers are found useful. See 

below to identify the computer ruler. 

 

Sometimes the ruler may not appear as you launch Microsoft Word. When this happens, do the 

following to make the ruler appear: 

Click on the view menu – click on ruler, and the ruler will appear. 

 

The computer ruler and the manual ruler have the same measurements. Use the manual ruler to 

measure the letter headed paper to know the exact measurement where the positions of the 



 

references are. Let‘s say 2 inches as you measured.  Locate 2 inches on the computer and type in the 

references. As you print, it would align with the headings of the references. 

 

Date 

There are two methods of typing dates. They are the British and American methods. With the 

British method you have the day, month and year for example, 2nd March 2009 or 2nd March, 

2009. But the American style would be month, day and year e.g. March 2nd 2009. The British style 

is the most common and preferred in Nigeria. The house style of either of the two could be adopted. 

To type the date, leave a minimum of three clear spaces and maximum of five clear spaces between 

the last lines of print on the letter headed paper and the typing line of the date. 

 

Attention Line 

In business letters, there are times the attention of someone else other than the addressee is drawn to 

the subject matter under discussion. In typing the attention line, there are two schools of thought – 

one school says the attention line should be typed before the addressee‘s address and the other 

school of thought says that the attention line should be typed immediately after the addressee‘s 

address. The opinion of the first school of thought is that the addressee might not notice the 

attention line soon after sighting the addressee‘s address; therefore it should be typed first to avoid 

oversight. The second school of thought feels that the addressee being the main person the letter is 

addressed to should have the honour first before the person whose attention is called to the subject 

matter. Again, any method used is acceptable depending on the prevailing house style. See the 

examples below: 

For the Attention of: Mrs. C. Okoro 

 

The Dean, 

School of Education, 

National Open University of Nigeria, 

14/16, Ahmadu Bello Way, 

Victoria Island, Lagos.  

     Attention line before the addressee‘s address

 

 

 

 

 

OR 

 

 

The Dean, 

School of Education, 

National Open University of Nigeria, 

14/16, Ahmadu Bello Way, 

Victoria Island, Lagos 

 

For the Attention of: Mrs. C. Okoro 

 

 

 

     Attention line after the addressee‘s address 

 

 

 



 

  

Whichever method that is used; single or double line clear spacing should be left in between the 

attention line and the addressee‘s address. 

 

Addressee’s Address 

This is the address of the recipient. It is typed in single line spacing. 

 

Salutation 

In business letters, the salutation is formal and it is usually typed as Dear  Sir/Dear Madam. Where 

the sex of the addressee is not known, the salutation should be Dear Sir. The salutation is typed one 

or two clear spaces after the addressee‘s address. 

 

Heading 

The heading introduces the letter. It gives an idea to the reader of what the content of the letter 

contains. The heading is also helpful in sorting of mails.  It  is  typed one or two clear spaces after 

salutation in capitals and bold. Preferably font size 14.  Once it is bold,  it should not be 

underscored (underlined). Both underscore and bold perform the same function of emphasis; 

therefore one should be used at a time. The heading should distinctly express the content. 

 

Body of the letter 

This is typed in single line spacing or at the most 1
1
/2 line spacing, with one or two clear line spaces 

in between paragraphs. 

 

Complimentary Close 

Business letter ends with ―Yours faithfully‖. Before now when the use of letter headed paper was 

not common the company‘s name is typed immediately after the complimentary close to show that 

the writer is writing on behalf of the company. 

Example 

Yours faithfully,  

NOUN 

These days, this practice is now obsolete, though some companies are still practicing it  out of 

ignorance.  Once a company‘s letter headed paper is used, it shows that the writer  is not 

autonomous rather he/she is standing in for the company.  Should there be a need  for legal action, it 

is the company that would be sued and not the individual because the individual was not 

representing himself/herself. Company‘s letter headed paper cannot be used for personal writing. 

 

Signature 

A space need to be left for the signature of the writer. Without the writer‘s signature, a business 

letter is disregarded because it is assumed somebody else would have done the writing. But there 

are occasions whereby someone else needs to sign for the supposed writer. This can be reflected in 



 

Sign. of Mr. Adeleke 

the designation. 

 

Designation 

This is the position the writer is holding in the company. The designation would signify the amount 

of importance that would be attached to the content of the letter.  Let us look at the following 

examples for clarity: 

 

Suppose Mr. O.A. Okonofua is the Sale‘s Manager in company ABC, and a letter need to be sent 

from his office to company XYZ to tender apology for the delay in the supply of goods to company 

XYZ, but it happens that Mr. O.A. Okonofua is  on  annual leave.  Some questions like, would the 

letter be put on hold until Mr. Okonofua returns from his annual leave? Can somebody else write on 

his behalf? 

 

It is Mr. Okonofua that is on annual leave and not the entire company. Therefore the normal 

business should still be carried out. Somebody would have been approved by the management of 

the company to act in his office while he was away for his annual leave. So the letter must be 

written in the office of the Sale‘s Manager. So the complimentary close and designation would 

appear thus, assuming Mr. K.E. Adeleke is the one acting in his office. 

 

Yours faithfully, 

K.E. Adeleke 

for Sale‘s Manager 

 

Sometimes it may be that the Sale‘s Manager is not on annual leave, but he is very busy with 

official matters. In this instance he could mandate any of his subordinates to sign on his behalf. This 

would still follow the same procedure as explained above. 

 

It is wrong to type in the name of the manager when he is not the one signing. The signature alone 

may not be enough to trace the actual person when the need arises. Using the example above, it will 

appear thus: 

 

 

Yours faithfully, 

ఌఎ    K. E. Adeleke‘s signature 

O. A. Okonofua  

for Sale‘s Manager 

This method must not be used. 

 



 

Another area of importance in a business letter is when a letter needs to pass through two or more 

officers before getting to the final addressee. For example if  a  course  coordinator or a programme 

leader is to send an official letter to the vice-chancellor, it would be wrong for the course 

coordinator or the programme leader to write straight.  Such a letter must pass through the Dean of 

the School where the course coordinator or programme leader belongs; say School of Arts and 

Social Sciences. 

 

The letter will be addressed thus: 

 

To:  The Vice Chancellor, 

National Open University of Nigeria,  

14/16, Ahmadu Bello Way, 

Victoria Island,  

Lagos. 

 

Through: The Dean, 

School of Arts and Social Sciences,  

National Open University of Nigeria,  

14/16, Ahmadu Bello Way, 

Victoria Island,  

Lagos. 

 

It is not compulsory that the ―through‖ must be typed in full. The abbreviation ―Thru‖  can be used. 

The layout pattern has two schools of thought. One school says that the address of the final person 

to act on the letter should come last while the first address should be the address of the officer 

that would act on the letter first. Following this school of thought, it means the above example 

would appear as follows; 

 

Thru:   The Dean, 

School of Arts and Social Sciences,  

National Open University of Nigeria,  

14/16, Ahmadu Bello Way, 

Victoria Island, 

Lagos. 

 

To:   The Vice Chancellor, 

National Open University of Nigeria,  

14/16, Ahmadu Bello Way, 

Victoria Island, Lagos. 

 



 

Suppose it is more than two addresses, say in a conventional university where a letter is routed from 

a lecturer through the Head of department, through the Dean of the faculty to the Vice Chancellor. 

Such letter will be addressed thus: 

 

Thru:   The Head of Department, 

Department of Educational Studies and Management,  

Faculty of Education, 

University of Benin,  

Benin City. 

 

Thru:   The Dean, 

Faculty of Education,  

University of Benin,  

Benin City. 

 

To:   The Vice Chancellor, 

University of Benin,  

Benin City. 

 

Remember it could be the vice chancellor first, followed by the Dean and then the Head  of 

Department. The two methods are acceptable depending on the most preferred by an individual or 

the house style of the organization. 

 

Where a personal business letter is written, a letter headed paper is not mandatory except where the 

individual has one. Let us see some samples of business letter. 

 



 

 
A simple business letter layout 

 

 

 

 



 

 
 



 

There are things to note in this letter: 

The space given after the end of print on the letter headed paper, 

The consistency in the line spacing, 

The signatory, and 

The space provided for signature. 

 

The space given after the end of print on the letter headed paper and the beginning of the letter, 

starting from the ―Date‖ is three clear spaces. Remember you could also use four clear spaces.  The 

mode of determining these spaces would be explained to you in unit 3 of this module. 

 

Also the spaces given between each section was consistent. In typing of letters,  use  single line 

spacing to type and give one clear space in between paragraphs. At the most use 1½ line spacing 

and two clear line spaces in between the paragraphs. 

 

The signatory is the registrar.  Nobody is signing for him.  Also enough space is given   for the 

signature. Remember you need to give four or five clear spaces for the signature. But supposing 

someone else is signing for the registrar, the display will go thus: 

 



 

 



 

Another important area of note is the style of presentation. The two main styles of business letters 

presentations are – blocked and indented. The commonly and widely accepted today, is the blocked 

style as used above. For the purpose of this course the two styles are presented thus: 

 

 

Blocked Style 

 

Long letters usually have continuation sheets. Plain sheet of the same quality of the letter headed 

paper is used as continuation sheet. The display of such continuation sheet may appear thus: 

 



 

 

Continuation Sheet of a Blocked Style 

But a letter that is displayed in indented style will appear thus: 

 

Indented Style 



 

In indented style, the first line of typing in each paragraph is indented five or six spaces to the 

right depending on the font size. This is set as ‗tab‘ default. To achieve this just press the ‗tab‘ key 

and it takes you to the desired point to start the first line in a paragraph. The complimentary close 

is typed starting from the middle of the document to the right. A continuation sheet of indented 

style will appear thus: 

 

 

Indented style continuation sheet 

 

Note the position of the first line of the addressee‘s address, the page number, the date and 

complimentary close. 

 

3.2 Memoranda 

The memoranda are another form of written communication in a business. The memoranda are 

used within an organisation. The singular form is memorandum. It is often abbreviated as ‗memo‘. 

Memo does not contain addressee‘s address, salutation and complimentary close, but it must be 

signed for the purpose of authority; which the document needs to carry. How should a memo be 

displayed? Let us see the following: 

 

 
 



 

Most companies also have memo headed paper. Where this applies, the memo has to be printed on 

the memo headed paper. There are equally long memo; which may run into another page. The 

continuation page should not be typed on the memo headed paper but on a plain paper. This may 

appear thus: 

 

 

3.3 Reports 

Reports are vital in an organisation. The report of a committee helps in decision making. The way 

reports are typed indicates the type of understanding the readers would receive.  A good report 

must reflect the following: 

 The body that constitute the committee 

 The date the committee was constituted 

 Members of the committee 

 The terms of reference 

 Procedure 

 Findings 

 Recommendations 

 

These usually form the major headings in a report. The headings could be presented as a shoulder 

or side headings. The shoulder heading is most recommended. 

 

Reports are typed in single line spacing and at the most, one and half line spacing with  size 12 in 

Times New Roman or Arial font type or any other font type within the same range. Where charts 

and table are required for illustrations, they must be well spaced in between lines or paragraphs. 

 

3.4 Minutes 

Minutes are typed in shoulder or side headings. Minutes could be presented in a tabular form. This 



 

depends on house style. But whether it is typed in plain or tabular form, the most important thing 

is to ensure that the major headings are well spelt out. 

 

3.5 Invoice 

Invoices are vital in a business environment. This may differ from business to business. First and 

foremost, identify the key words that are required to describe the goods to be transacted in the 

business. Invoice is presented in a combination of straight typing and tabulation. Here is an 

example of an invoice: 

 

 
 

 

 

 
 

3.6 Newsletters/Flyers 

Newsletters and flyers are usually display work. This may require the use of dropped caps and 

column typing. To insert ‗Drop Cap‘. Type the words and highlight the letter that you want drop 

e.g.  . Then click on ‗Insert‘ and click on ‗Drop Cap‘, the following drop menu will 

appear: 



 

 
 

Click as desired and follow the instruction. If the document is to be presented  in  columns, click 

on ‗Page Layout‘ and click on ‗Columns‘, it will appear thus: 

 

 

Select as desired, and follow the instructions. 

 

In selecting new document you can insert default template. To get this done, click on ―Office 

Button‖ → ―New‖→ select from the displayed templates → follow given instructions in the 

template. 

 

3.7 Tables 

To insert a table in a document, click on ―Insert‖ → click ―Table‖, the following drop down menu 

will appear thus: 



 

 

 

Select the rows and columns as desired as you point the cursor through the boxes. Click after you 

have selected the desired rows and columns. But where the desired rows and columns go beyond 

the specified rows, click on ―Insert Table‖ and select as desired. 

 

The challenges that are usually encountered in tabular work include: 

 Addition of rows 

 Addition of columns 

 Deletion of rows 

 Deletion of columns 

 Splitting of cells 

 Merging of cells 

 Text Direction 

 Border and shading 

 

Now let us see how these can be achieved using the table below: 

 

  

  

 

To add row(s) to the above table, do the following: There are different ways to achieve this. First, 

place your cursor on the right edge of the last row as shown below: 

 

 



 

 
 

and press the enter key. As soon as the enter key is pressed a third row would appear. 

 

  

  

  

 

Another way is to highlight, the number of row(s) to be inserted, see example below: 

 

With the cursor still in the cell click on ―layout‖ and the following will appear: 

 

 

 

 

 

 

 

Then click on any of the following in the drop down menu as desired: 

 

 

 

 

 

 

From this menu, you can also delete unwanted row and column. To merge or split cells, select as 

desired from the following section in the menu, while the cursor is placed on the required cell(s): 

 

Still on the ―Layout‖ menu, you can align your text within the cell, set your text direction and sort 

data. 



 

There are times you want to add boarder or  shading to a cell or some group of  cells within a 

table. To achieve this highlight the cell(s) required and right click,  the following would appear: 

 

Click on ―Table Properties‖. The following will appear: 

 

 

 

Click on ―Borders and Shading‖ 



 

 
 

 

Then click on ―v‖ shape in the box beside ―No Color‖, the following drop down menu will appear: 

 

Choose desired colour, and click OK and OK in the underneath box. The  highlighted  part will 

appear thus: 

 

Name Country City 

   

 

You can equally use the ―Apply to‖ in the dialog box to select the desired position within the table 

where you want the colour to appear. 

 

Another method of achieving this is to highlight the cell or cells to be shaded and right click, then 

click on  ―Border and Shading‖, a dialog box will appear, click on ―Shading‖  to see exactly the 

appearance of the dialog box below: 



 

 
 

Then select colour and apply as desired. 

 

3.8 Charts and Diagrams 

Charts and diagrams are used for illustrations. They help to enhance information in a business 

environment. To insert a chart on a document, click on ―Insert‖ → click on ―Chart‖ and the 

following dialog box will appear: 

 

 

Select the desired chart. Suppose, a pie is selected, the following will appear: 

 



 

 
 

 

Once you are done with the data entry close the excel worksheet, then the chart will appear. It can 

be resized by clicking and dragging. To edit the chart, right click on the chart and click ―edit data‖. 

To insert diagrams, click on ―Insert‖ → picture/Clip Art/Shapes/SmartArt as desired. Within the 

shapes, it is only textbox you can easily type inside the box. To type text into other shapes, right 

click on the shape and click add text, a cursor will appear.  As soon as  a cursor appears type 

whatever you wish to type. 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Type an invitation letter, inviting an applicant to an interview in a particular organisation. 

Describe the format adopted including the line spacing. 

2. Get samples of various documents as discussed and practise the typing as described above. 

Cross check your typing with the above specifications. 

3. Type a report that includes charts, tables and diagrams as illustrations from any source of 

Type in the desired 
headings and figures to 
over- write the default 
prints, and delete the 
default where not required 
in the excel worksheet 



 

your choice. 

 

   5.0 Conclusion 

Document production is a vital aspect of business communication. To produce a good business 

document requires adequate practice. Therefore ensure you practice more  of this. 

 

    6.0 Summary 

Document production includes business letters, memoranda, invoice charts, and diagrams. 
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   1.0 Introduction 

Data security is very important in business. You need to secure the data or information generated 

or received for the following reasons: 

i. for the purpose of future use; 

ii. for easy retrieval; 

iii. for confidentiality; 

 

From time to time information or data are usually referred to for the smooth running of any 

business. There are time that vital data or information need to be kept for future use.  In this case 

the data need to be well secured, failing which there would be a problem at the time the data is 

needed for use. It is not all information or data that provide their usefulness at the immediate; 

some of them are found useful at a later date.  Therefore such data must be well kept so as not to 

run into problem of need. 

It would be meaningless if information or data kept for future use cannot be retrieved at the time 

of need. This is more frustrating than not having the information or data at the first instance. 

Finally, for the purpose of confidentiality, information or data need to be well secured. This covers 

both present and future use of data or information. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 



 

 apply the basic procedure of securing data; 

 explain the basic process of disposing data; 

 explain simple procedure of data storage. 

 

   3.0 Main Content 

3.1 The use of password 

The personal computer can be secured without unauthorised persons having access to use it. The 

use of the personal computer could be personalised by the use of password. Except the right 

password is typed in, the computer cannot be used. In this case it means the user has to make the 

password personal.  If not anybody that has the password can use it. To personalise the use of a 

personal computer, seek the advice of a computer engineer. 

 

Apart from using the password to personalise the use of a personal computer, it  could also be used 

to secure access to documents. In this case, anybody can have access to the computer but any 

anybody cannot have access to the documents that have password, except the person who has the 

password. To password a document, use the following method: 

 

Stage one: Type the document 

Stage two: Save the document. Do this: 

Click on ―File Tab‖ with your document opened. 

 

 
 

 



 

From the dropped down menu 

 
 

Click on ―Save‖ or ―Save As‖;  

 

 
 

Under ―Save As‖, decide your save location 



 

 
 

Now note the following: 

 

 

 
 

 



 

What is unique in these arrows? 

 

The source name – this is the source where you want your document to be saved. The source name 

in the above dialog box shows ―Public Document‖ this means that the document is saved or is 

going to be saved under the folder named ―Public Document‖.  

 

Another important aspect of the arrow is the ―File name‖. Type in the name in which you want the 

file to be saved, using the example on the dialog box above, the file name is ―A Midsummer 

Night‖ i.e. the name the document is saved with. A name must be given for identification, easy 

sorting and retrieval. Do not use a name you cannot easily retrieve your file with. 

 
 

Then the ―Tools‖. Click on the black ‗v‘ like shape at the bottom: 

 

 

A dialog box will appear thus: 

 

 



 

Click on ―General Options‖, and a dialog box will appear thus: 

 
 

 

In the above dialog box, take a look at the directions of the three arrows: 

In the first arrow in the box, type in the name you wish to use as the password e.g. kate. You must 

use a name you can easily remember, if not you may not be able to open your document. Also 

mind the ‗case‘ of letters used i.e. upper case (capital letters - KATE), initial case (Kate) or lower 

case (small letters – kate). You would notice that though the name is the same, the way they are 

typed is not the same. It is the way the password is recorded at the initial stage that the computer 

would recognise when opening the document. 

 

In the second arrow, type in the same password name, it will prompt an error if there is a 

difference. 

 

Click on the small box where the third arrow is pointing to if you want your document to be ready 

only. What this means is that when the document is opened, you  may not be  able to effect any 

correction, but can only read. It is advisable not to click on the box, except when you want to make 

your document read only. 

 

After this process, click on OK, and a dialog box will appear thus: 

 



 

 
Go through the process once more and ensure you have 
mastered the procedure before you continue to the next 
stage. 

Re-enter the password in the space provided and click OK. The same box may come up again, 

re-enter the same password and click OK. Then click save at the main box underneath. 

 
 

After this first saving, any other information added to the document would be saved by clicking 

on ―save‘ from the file menu or press ―ctrl + s‖. 

 

To open a file that is having a password, a click on the document would produce a dialog box 

where the password would be typed in before it can open. 

 

 

3.2 Data Storage 

There are two basic ways to store data – internal and external devices. 

 

3.2.1 Internal Device 

A part of the internal device has been discussed along with the password. But it is important to 

note that documents could be saved in: 

i. my document 

ii. my computer – for the internal device under my computer, the saving device is the Local 

Disk (C:) 



 

iii. Desktop 

 

My document is usually set at the default. Once ‗save as‘ is clicked, the source directory that 

comes up is ‗my document‘. Once saving is done through that source, it means the  file will be 

domiciled in ‗my document‘. To change the source directory from ‗my document‘ click on the 

‗v‘ black shape beside the source box as shown in the description of ‗password‘ and select as 

desired. Saving on the Local Disk (C:) means saving on the hard disk. 

 

You could save a particular file on both directories i.e. on ‗my document‘ and on ‗local disk 

(C:)‘, one would then act as a back-up file. Should there be a problem with one directory; the file 

could then be retrieved from the other directory. 

 

The best source to save your document is ―My document‖. Saving in the Local Disk (C)  is not 

too secured especially when there is the need to re-format the disk. The saved file may not be 

recognised. And saving at the Desktop may slow down the speed of your computer. 

 

Remember, to save a document, click on file, from the dropped down menu click on ‗save as‘, 

follow the direction on the dropped down menu. 

 

3.2.2 External Device 

Documents could also be stored through the external device through 3½ floppy (A:), 

DVD/CD(D), Pen Drive or Flash Drive and the use of external hard disk. To save on the external 

device, go through the normal process of saving. The major difference in the saving is the 

selected source where the document would be saved. Remember to click on the ‗>>‘ shape black 

button to select the desired source. 

 
 

 

3.3 Data Disposal 

What do you do when you no longer need a particular file or document? 

Different questions come to mind: 

 Am I sure I no longer need this document? 

 Would there be a need of it in the future? 

 Is the document a confidential document? 

 How do I dispose the document? 

 

These and many other questions may come to mind. But the most worrisome is when the 



 

document is a confidential one.  It means it must be disposed without a trace.  A leakage in 

confidential documents could cause the company great distress. 

 

If the file or document is not a confidential document, the normal delete can be used. In this 

instance it means that the deleted document or file would be resided in the recycle bin, which can 

be culled back if need be. But where confidential documents or files are involved, not only 

should the document be deleted from the source file name but must also be deleted from the 

recycle bin. For a very high confidential document, the knowledge of an engineer may be sought 

to ensure proper disposal to avoid any trace that may be carried out by experts who may want to 

retrieve the unwanted data by all means. 

 

When you are disposing the electronic data, do not forget to look at the ‗hard copy‘  if any. The 

hard copy is the printed copy of the document. Where there is no need for it dispose it through 

the use of trash bin. Do not burn, do not release for re-cycling and do not give to petty traders to 

use as wrappers for their wares. Any of these methods may  lead to exposing the confidentiality 

of the document. 

 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Visit any organisation of your choice, and state the mode of data disposal that is used in 

the organisation. Share your findings with your colleagues and facilitator. 

2. With reference to a particular organisation, explain how vital information can be 

protected in a business. 

 

   5.0 Conclusion 

In conclusion, do not hastily dispose your documents or files; ensure you are done with them 

before disposing them off. Choose the right mode of discarding your files.  Your data or 

information must not litter the environment.  Remember that an information or data that is not 

properly secured could lead the organisation into a doom. 

 

    6.0 Summary 

To secure data or documents or files, the use of password is considered very helpful. The 

personal computer could use password to personalise the usage. Where this is not done, the file 

or document could be saved with password, which means the document or  file  can only be 

opened with the use of the recognised password by the computer. 



 

 

The user of the computer could choose where a document or file should be saved. File could be 

saved through the internal device or external device. Both could also be used. 

 

But where by a file is no more needed an appropriate means should be used to discard the file 

without allowing the information to litter the environment. 
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   1.0 Introduction 

File management was very pronounced in the office before the advent of the modern office. This 

was usually referred to as filling system, where filing is done horizontally, vertically, 

geographically, numerically, departmentally, alphabetically and by subject.  But today, most 

people have lost sight of this various mode of filling systems because they feel it is only 

associated with manual filling system since the office today speaks Information Technology. 

This is where the problem lies. Most users of the personal computer find it difficult to manage 

their files, hence the problem of retrieving files especially when the person that created the file is 

not available. This unit will teach you on how to manage electronic files. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Create and Organise electronic files, 

 Create and Organise electronic folders. 

 

   3.0 Main Content 

3.1 Creating a File 

Remember in the past unit, we have discussed a little on how to create files. As a refresher on 

creation of files, let us consider this case study. 

 



 

Case Study 

National Open University of Nigeria has various schools and units divided as follows: 

 

Schools - School of Arts and Social Sciences 

School of Education 

School of Business and Human Resources  

School of Science and Technology School of Law 

 

Units  - The Vice Chancellor‘s Office 

The Office of the Deputy Vice Chancellor (Academics) 

The Office of the Deputy Vice Chancellor (Administration) 

The Office of the Registrar 

Centre for Continuing Education and Work Training (CCE & WT) 

Foundation Programmes (Access and General Studies) 

Study Centres 

 

These are some of the units that exist in the university. 

The university is systems where by the various sub units interact to achieve the set goals. The 

major mode of interaction is written communication; which is produced electronically. Also the 

university may also need to interact with the environment, this include the public, other 

organisation and government. To have an effective interaction also requires the use of computer. 

 

Since the schools and units need each other to contribute to the welfare of the university, it 

means each of them has to keep an up-to-date record of each other interaction to have a good 

link.  But for the purpose of this course material, let us consider the record system   in the office 

of the Registrar. 

In the office of the Registrar, mail would be sent and received from all the existing  schools and 

units as well as the government parastatals and  other  concerned organisations. 

 

Question 

How would the mail be organised electronically for easy retrieval?  

Procedure 

For the documents going out of the Registrar‘s office, files have to be created for them. A file is 

for identification. To make the identification much easier, a name is attached hence ‗file name‘. 

The file name is the name given to the file for proper identification. Just as you have name of 

persons such as John, Modupe, Adewale, Ajadi, Okoli, so as to be able to identify the particular 

person that is being referred to. So for every document that is created, it has to be saved with a 

file name. You may apply the following process: 

 Type the document 

 Click on Office Button 



 

Folder Arch file 

Documents 

 Click on ‗Save As‘ 

 From the dialog box select the source as desired 

Through this method several files would have been created. The same procedure would be 

adopted in saving a document received. The only difference would be that, you are not the one to 

create the document rather you have to scan the document, import and save with a desired file 

name. In this regard, it is assumed that the files created in the Registrar‘s office may include: 

 Dr. J. K. Adedeji 

 Prof. O. M. Komolafe 

 Mrs. A. A. Kadiri 

 Dr. J. B. Jubrin 

 Leave Notification 

 Advertisement for Academic Vacancy 

 Workshop on Course Writing 

 Computer supplies 

 Advertisement for Contractors 

 Senate Minutes 

 Students‘ Academic Records 

In creating a file name, the right name needs to be used for easy sorting. Therefore the name 

given to a file must be reflective of the content of the document. 

 

3.2 Organisation of Files 

There are already created files.  This may run into several hundreds, thousands and even more.  

So if they are not properly organised there will be difficulty locating a file at the point of need. 

This is where file organisation becomes very vital. To sort files appropriately, the file names 

must be reflective of the document if not the file may be placed wrongly and would lead to 

difficulty in the process of retrieving same. 

There are files that need to go together.  Files in the electronic way are documents.  So   we are 

now talking about putting related documents together in one box i.e. the folder. This could be 

likened to the normal manual flat file folder or arch file where documents of related matters are 

kept. 



 

The list of files above from the registrar‘s office has to be sorted so that related documents have 

to be kept in the same folder for easy identification. 

 

3.3 Creating a Folder 

How do I create a folder? To create a folder, do the following: 

 

There are a couple of ways to open File Explorer. The shortcut Win+E will open File Explorer. It 

can also be opened by clicking the Start button and typing ―File Explorer‖ or by right-clicking 

any folder and selecting Open. By default, File Explorer is pinned to the task bar (see below), 

and it can be opened from there. 

 

 
 

Some folders already exist in File Explorer, such as Documents, Desktop, and Downloads. 

(Documents may be called ―My Documents‖ in older versions of Windows). You can create 

more folders or folders within folders to allow for better organization. 

To create a folder, right-click, then select New>Folder. 

 

Comment [D5]: Changed from 
windows xp to windows 10 



 

 
 

In Windows 7, there is a New folder button near the top of the window. In Windows 10, you can 

also click the Home tab, then the New Folder button. 

 
Windows 7 New folder button 

 



 

 
Windows 10 New folder button 

 

Note: Follow this procedure to create as many folders as desired. Working with the files from the 

registrar‘s office as indicated above, all the files are not related. To make files more manageable, 

we have to sort into schools and units. So in this instance folders should be opened for the 

various schools and units. 

 

Enter files into folder. There are two ways of entering files into folder. 

 

First, if the files have been created, open the source where the files are and open the folder. Copy 

the file(s) and paste inside the folder using the cut and paste mode.  Sometimes both the folder 

and the file(s) may be in the same source like my document. E.g. 

 



 

 

The folders are in yellow colour. The others are files. Let us assume we want to put the files into 

the folder named ‗New Folder‖. Right click on the file, a dropped down menu will come up, 

from the dropped down menu click on ‗copy‘ then go to the folder (New Folder) where you want 

to copy the file, double click (i.e. fast click twice) and the folder will open thus: 

 

 
 

This shows there is no file in the folder. Right click inside the white space and from the dropped 

down menu, click on paste. Let assumed the file we copy is ‗Methodology‘, as you click on paste 

the file will appear on the folder thus: 

 
 

You can enter as many files in this order. But you must ensure that the files entered are related to 

the name given to the folder, because the folder is acting as the umbrella. Apart from copying the 

files one by one you could highlight all the files you want to copy, right click and click on copy 

and go to the folder, right click and click on paste, all the files copied would be pasted at once. 

 



 

 

 
 

You could also use drag and drop method. With this method, left click on the file, hold down the 

mouse without releasing your finger and take the cursor to the folder and  release your finger. As 

soon as this is done, the file(s) automatically copy into the folder. 

 

The best method is: 

 to create a folder first 

 then type the document 

 click on file 

 click on save as 

 click on the source where you want the document saved e.g. my documents 

 click on the folder you have created 

 and save 

 

3.4 Organi sation of Folders 

Remember you have created folders for all the schools and units in National Open University of 

Nigeria. If the folders are left to exist the way they are, they will turn to junks i.e. it will again 

become unmanageable. Therefore there is a need to arrange these folders. Take for example, the 

folder named ‗school of education‘ in the Registrar‘s  office. There are so many letters going and 

coming from School of Education. Putting everything together will not make it manageable, so 

there is a need to create other folders within the folder ‗school of education‘. 

 

But before creating folders within the school of education, yearly folders e.g. 2002 folder, 2003 

folder, 2004 folder etc need to be created and within each year folder two major folders need to 

be created in office of the Registrar. These folders are ‗Incoming Mail folder‘ and ‗Outgoing 



 

Mail Folder‘. Folders for all the schools and units in the university would be present in both the 

incoming mail folder and the out-going mail folder. This is for easy retrieval. The incoming 

mails should be recorded electronically both the ones that are received in electronic form and 

those that are received in hardcopy form. The hard copy form would be made possible through 

scanning. 

 

Within each school or unit folder, other folders can now be created e.g. staff record, facilitators 

update, Notice of Senate meeting etc. 

To save folder inside another folder, follow the same procedure of saving file(s) inside folder. 

 

 

4.0  4.0  Self-Assessment Exercise(s) 

Answer the following questions:  

1. With reference to a particular organisation, explain the process of managing a file in a 

business. 

 

   5.0 Conclusion 

To be effective and efficient in an organisation, documents must be properly managed failing 

which the efficiency level will be very low. Low efficiency could increase the problem of quality 

assurance which is sought by the public. Therefore the issue of file management must be 

considered very vital in the business world. 

 

    6.0 Summary 

To have adequate file management, create files with file names that can easily be retrieved and 

arranged them in manageable folders for easy retrieval and control. 
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   1.0 Introduction 

The way documents are presented speaks about the integrity of an organisation. A document may 

carry good information, but if the document has poor presentation, such document would send 

wrong signals in spite of the good information it possesses. This is why document presentation is 

very important in business. This unit would therefore be devoted to discussing different areas 

that are eye catching in document presentation. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Format documents 

 Review documents 

 

   3.0 Main Content 

3.1 Formatting 

There are different types of formatting: 

 

Simple Character Formatting e.g. underline, bold, italicize your text: 

To achieve this, click on Home on the menu bar and click the desired formatting - 

 



 

 
 

Short cut keys could also be used. Press ctrl + B for bold, ctrl + I for italic and ctrl + U for 

underscore. Press one of the shortcuts before you type the text you want to format. When you 

want to stop formatting, press the same shortcut key to turn off the formatting.  You can also 

format already typed document. To format already typed document, highlight the desired part 

and select the desired format. 

 

Special character formatting: These are used to enrich the document. This may be ―Page 

Background‖, which may include watermark, page colour and page borders. You may also want 

to effect ―Page Setup‖ or work in different ―Paragraphs‖. To achieve any of these, click on ―Page 

Layout‖ in the menu and select as desired. 

 

 
 

To have special effect on font like subscript and superscript, click on ―Home‖ in the menu and 

select from: 

for example to type 9 to the power of 3, type 9 and 3 thus 93, highlight 3 thus and click X
2
 button 

 

then it will appear thus 9
3
. 

 

To achieve paragraph formatting, click on ―Page Layout‖ and select the desire format under 

―paragraph‖. 

 

3.2 Proofreading 

It is important to proofread a typed job before it is sent out of the organisation. This is best 

achieved by the use of Thesaurus, spelling and grammar tools. To get this click on ―Review‖ and 

select as desired. A quick type can be done by highlighting the desired word(s) and right click on 



 

the word to check for spellings and grammar. Sometimes, the computers automatically prompt 

green or red waiving lines. The green waiving line queries grammar, while the red waiving line 

queries spellings. These serve as alert to proofreading. 

 

 
 

Another important aspect of proofreading is the use of ―Track Changes‖.  This will enable you to 

edit materials electronically. 

 

3.3 Mail Merging 

Mail merging is very important in the production of business documents. There are times there is 

the need to send the same content of a document to several persons probably with different 

names and addresses. In this instance, mail merging is the best option that can be used to achieve 

such documentation within a short time. 

 

To mail merge, the following steps may be taken: 

First, prepare a table for the information that would be different in the document e.g. name and 

address. This may appear thus: 

 

Name Address 

John Mark 12 Street 

Benin City 

Ojo Adekunle 23 Abiola Avenue 

Lagos 

Okoro Nduka School of Education 

NOUN, Lagos 

 

Pius Ehimen 

Department of Arts and Social Sciences Lagos 

State University 

Ojo 

Caroline Ujagbe 56 Lane Close 

Kano 

 

Dada Ojugo 

Plot 547 Arewa Suit 

Abuja 

Ibhagbosoria Uduaghe 99 Ajuwa Avenue 

Sokoto 



 

 

Save the table in appropriate source.  

Secondly, type the document, say a letter e.g. 

Dear, 

 

We are glad to inform you that our interest rate has been reviewed downwards. You are now to 

pay 2.5% on any outstanding loan as from the month of September, 2009 as against the 6% 

earlier charged. 

 

Should you need further clarification, please feel free to ask.  

Yours Sincerely, 

 

This letter is to be sent to different persons and addresses. So let us identify where the names and 

addresses would be inserted. 

 

―Address‖ 

Dear ―Name‖ 

 

We are glad to inform you that our interest rate has been reviewed downwards. You are now to 

pay 2.5% on any outstanding loan as from the month of September, 2009 as against the 6% 

earlier charged. 

 

Should you need further clarification, please feel free to ask.  

Yours Sincerely, 

 

Thirdly, place the cursor on the document and click on ―Mailings‖ at the menu bar. Then click 

Mail Merge → Step by step mail merge wizard, then a drop down menu will appear thus at the 

right hand side of the screen: 

 
 



 

 
 

At the bottom of the drop down menu click on ―Next: Starting document‖, and follow the 

instructions. 

 

When you click on step 3 a dialog box will appear requesting for your existing list. Click on the 

source to open the file. With our above list, this will appear: 

 

 
Then click OK.  A click on step 4 will bring the following dialog box 

 



 

 

Place your cursor on the first place of insertion, in this instance where you want the address to be 

placed then click on ―More items‖, the following dialog box will appear: 

 

Click Insert. Repeat this in all the points of insertion. A click on step 5 will effect all the 

identified names and addresses. 

To enhance the mail, you may work through the icons on ―Mailings‖ 

 

 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Edit a material electronically, and share your experience with your colleagues. 

2. With the use of mail merge, type a letter and duplicate same to 10 persons. 

3. Edit any material of your choice with the use of ―Track Changes‖. Use balloon to show 

the changes in the text and print. 

 

   5.0 Conclusion 

It is good to present our documents in a way to enhance understanding and as well as gaining 

time. 

 

    6.0 Summary 

In presenting a business document, attention should be given to appropriate formatting as well as 



 

time gaining techniques, such as mail merging. 
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Module 3: MICROSOFT EXCEL IN BUSINESS 

 

Module Introduction 

Microsoft Excel is very useful in the business world, especially in the computation of data that 

involve figures and complicated tabulations. This module would discuss the day-to-day activities 

that require the use of excel in business. BED 211 – Microsoft Office has already introduced us 

to Microsoft Office Excel, therefore, this module would focus on the use of excel for problem 

solving in business. Microsoft Office Excel 2010/2013 would be used in this module to discuss 

the following: 

 

Unit 1:  Solving and Making Decision with Microsoft Excel  

Unit 2:  Managing Large Worksheet 

Unit 3:  Presentation of Data with Charts 

 

Unit 1: Solving and Making Decision with Microsoft Excel 

 

Contents 

1.0 Introduction 

2.0 Intended Learning Outcomes (ILOs) 

3.0 Main Content 

3.1 Identification of Business Problems 

3.2 Problem Analysis 

3.3 Identification of Possible Solution 

4.0 Self-Assessment Exercise(s) 

5.0 Conclusion 

6.0 Summary 

7.0 Further Readings 

 

   1.0 Introduction 

In Microsoft Word, we study some tabular work which involves the use of columns, rows, and 

cells. But there is a limit to which Microsoft word can handle tabular work, especially when 

advanced calculations are involved. This is where Microsoft Excel comes in. This unit will 

expose you to the beginning part of the use of Microsoft Excel. 

 

 

Comment [D6]: Updated the use of 
Microsoft excel 2007 to 2010/2013 and 
windows xp/7 to windows 10.  
Improved on the references and further 
readings. Expunged the very old 
references and incorporated recent 
references and books for further 
readings. 



 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Solve basic problems in business by applying basic statistics with the use of Excel. 

 Analyse basic problems with the use of Microsoft excel. 

 

   3.0 Main Content 

3.1 Identification of Business Problems 

Excel works with columns, rows and cells. Sometimes problem may occur in the use of 

formulas, using formulas and cell references instead of values and determining order of 

preferences. Let us look at some areas that may require problem identification: 

 

 

 

Excel Arithmetical Operations – 

 

Calculation Excel Operations Example 

Addition + =3+A1 

Subtraction - =A1-A2 

Multiplication * =A1*4 

Division / =X4/Y4 

Exponent ^ =2^8 

 

You will recall that in BED 211 – Microsoft Office, we were told that every formula in excel 

starts with ‗=‘ sign. By way of interpretation, under the column of example above, the equal sign 

is mandatory. =3+A1 means the value 3 is added to any value that is in cell A1. In the second 

row, =A1-A2, it means the value in A2 is subtracted from the value in A1. In the third row, 

=A1*4 means the value in A1 is multiplied by the value 4. The fourth row =X4/Y4 means the 

value in X4 is divided by the value in Y4 and finally   in the fifth row =2^8, it means the value 2 

is raised to the power of 8. The day-to-day activities in the business world require these basic 

arithmetical operations for business to flow. For example, a business man may want to get the 

total amount of sales per month and year. In this case, it means monthly sales should reflect as 

well as the summation per year. Also the business man may want to get the net profit, by 

subtracting all expenses from the gross profit made. This can be achieved by simply entering the 

right formula to capture the right value. 

 

Formulae and Cell References instead of values – 

Supposing the cost of producing 1000 copies of a textbook is N3,235, the cost of one textbook 



 

will be N3,235 divided by 1000.  Using excel formula it will be N3,235/1000.   It is wrong to 

type a value into a cell instead of entering the formula that produced the value. Typing a value 

will make your work cumbersome and you will find it difficult to reference cells. To work with 

formulae accurately and with fewer problems you need to know how to determine order of 

precedence   rules. 

 

Order of Precedence Rules 

Order 

Precedence 
of Example Resulting 

Value 
Explanation 

1. Operations  

parentheses 

in =A1*(3+5) If A1=2, the 

resulting 

value is 

2*(3+5), or 

2*8 = 16 

Excel first performs the 

addition of 3 + 5 even 

though multiplication 

has a higher precedence 

than addition, because 

the addition operation is 

enclosed in parentheses 

2. Exponentiation =3*A1^3 If A1 = 2, the 

resulting 

value is 

3*2^3 or 3x8 

= 24 

Excel first performs the 

exponential operation of 

cubing A1, and then 

performs   the 

multiplication 

3.  Multiplication 

and  division 

from left to 

right 

=A1 + B2* 

C3 

If  A1=2, B=3 

and C3 = 10, 

the resulting 

value is 

2+3*10      or 
2+30 = 32 

Excel first multiples B2 

by C3, and then adds 

the result to A1 

4.  Addition 

subtraction 

from left 

right 

and 

to 

=A1- 

B2+C3/10 

If A1=2, 

B2=3, and 

C3=10, the 

resulting 

value is 2-3+1 
or -1+1=0 

Excel first  divides  C3 

by 10, then subtracts B2 

from   A1, and finally 

adds this value to the 

quotient 

 

3.2 Problem Analysis 

The following is a case study: 

 

Sharback manufactures and sells Adire (tie and dye) clothes at Abeokuta, a town which is 

distinctly known for good Adire clothes. Due to the popularity of this Adire, the company is 

challenged to meet the demand. The manufacturing company is forced to add volume to the 

quantity manufactured so as to be able to meet with the demand. Sharback is committed to 

maintaining a high standard for which the company is known, but there is a great concern that 



 

the standard may be compromised due to increase in production. One of the problems in the 

production process is Quality Control, which is often referred to as ―QC‖. Each Adire is 

thoroughly inspected and tested before being released for sale when a defect is detected. The 

defect is traced to the original production line that manufactures and package the Adire. Adewale 

who is the control manager noticed an increase in defect products since the increase in the 

production of Adire. The fear arose that the company may not be able to meet the demand if the 

numbers of defected goods keep increasing. 

In this instance, Adewale would need statistics for the analysis statistics for thorough 

analysis.. 

 

Using Statistical Functions of Data Values 

The skills required in using statistical functions include: 

 Freezing rows and columns 

 Splitting a window into panes 

 Using absolute references 

 Using the AVERAGE function 

 Using relative references 

 Using the ROUND function 

 

Statistics is often referred to as a subset of mathematics, which is applied to observe data. 

Some common statistics that are used are: 

 Mean 

 Median 

 Mode 

 Standard deviation 

 

The mean is the arithmetical average of a set of data.  Median is the arithmetical value that 

occurs in the middle of a set of data. Mode is the arithmetic value that occurs most frequently in 

a set of data. Standard deviation is a measure of how widely data values are dispersed from the 

arithmetical mean. Let us see the following examples: 

 

Values: 8, 7, 2, 2, & 10 

a. Arithmetic mean = (8+7+2+2+10)/5 

b. Median = to get the median, reorder the value in ascending order thus: 

2, 2, 7, 8, 10, the middle value 7 is the median. 

c. The mode is the value that occurs most often, in this set of data, the mode is 2. 

d. The standard deviation is the degree which scores spread out about the mean or 

central tendency. 

 



 

The mean in two sets of data might be the same but with different standard deviation, which 

shows the data is more or less widely distributed or could exhibit entirely different distribution 

profile. Also two data might have the same standard deviation and the mean values in the same 

data could be different, this indicates two dissimilar manners. 

 

In the case of Sharback Adire production, Adewale must analyse the recent trend in Adire being 

rejected in the quantity control for quality defects. The two most common defects being found in 

the Sharback Adire models are as follows: 

 

 High colour coefficient indicating poor surface finishing that can result in fast fading of 

material. Adires are rejected if the colour mixture differ from the actual colour number with 

 0.01 

 Low texture strength indicating that the material texture cannot absolve the desired 

colour. The Adires are rejected if the texture of material is less than 0.7 

 

The problem has under gone some analysis, the next stage would be to identify possible solution. 

 

3.3 Identification of Possible Solution 

To be able to identify the possible solution that excel can provide the following are essential: 

In statistical value, you may want to ROUND functions e.g. 26.436 would be 26. Examples of 

ROUND functions are: 

 

Formula Description Resulting Value 

=ROUND (26.436) Rounds 26.436 to the 

nearest whole number 

26 

=ROUND (B2,1) Where B2 contains 21 

 value 21.38, round 

21.38 to  the nearest 

tenth 

 

=ROUND (102234,-2) Rounds 102234 to the 

nearest hundred 

102,200 

=ROUND (33.75%,2) Rounds 33.75% to the 

nearest hundredth, which 

is the same as  the nearest

  percent 

because the precise 

value is 3375 

 

 

24% 



 

=ROUND 

(SUM(10.33,10.44),0 

First sum 20.33 and 

20.44 resulting in 

40.77, then round the 

value to the nearest 

whole number 
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These functions can also be expressed in excel. Let us see the following: 

Examples of Functions that modify the precision of a value 

 

Function Description Syntax and Example 
Resulting 

Value 

 
 

ROUND 

Rounds a 

number to a 

specified 

number of 

decimal places 

 

ROUND (number, num- 

digits) = 

ROUND(25.33%,2) 

 
 

25% 

 
 

ROUND-UP 

Rounds a 

number up to 

the specified 

number of 

decimal places 

 

ROUND(number, num- 

digits) = 

ROUNDUP(1.002,2) 

 
 

1.01 

 
ROUND 

DOWN 

Rounds a 

number down 

to the specified 

number of 

places 

 

ROUNDDOWN 

(number, num-digits) = 

ROUNDDOWN(9.99,0) 

 
 

9 

 
 

EVEN 

Rounds a 

number up to 

the next 

highest even 

integer 

 
EVEN (Number) = 

EVEN(2.23) 

 
 

4 

 

 

ODD 

Rounds a 

number up to 

the next 

highest odd 

integer 

 

ODD (number) = 

ODD(1.23) 

 

 

3 

 

INT 

Round a 

number down 

to the nearest 

integer 

 

INT (number) 

= INT(-4.3) 

 

-5 



 

 

 

TRUNC 

Truncates a 

number to an 

integer 

removing the 

fractional part 

of the number 

 

TRUNC (Number, 

num-digits) 

= TRUNC(-4.3) 

 

 

-4 

 

Paste Special 

The copy and paste mode is the same in what we have learned in BED 111 (Introduction to 

Keyboarding and Word Processing), BED 112 ( Advanced Word Processing) and BED 211 

(Microsoft Office). But there are situations where you need to use the paste special mode. When 

you click on paste special; click on the desired function. As a reminder, let us look at the 

following Paste Special box: 

 

Let us see the explanations of some of these paste functions in the table below: 

 

Formulas Description 

Paste Special Displays a dialog box that provides 

different paste options 

Formulae Paste only the formulae from the 

original (copied) cells 

 

Values 

Paste only the values from the 

original cell(s); the formula or any 

formatting are not pasted 

 

All except Borders 

Paste the formulae and formatting 

from the original cell(s), but not the 

format of the cell borders 



 

 

 

Transpose 

Paste the formulae and formatting from 

the original range of cells, but reverses 

the orientations, so that the rows of the 

original cell range, and 

the original columns become rows 

 

Paste Link 

Paste a connection or link to the 

original cells, including the applied 

formatting 

Paste operations (Add, Subtract, 

Multiply and Divide) 

Paste the operation so specified 

 

Mean, Median, Mode and Standard Deviation 

Excel Statistical Functions 

Statistic Function and Syntax 

Arithmetic Mean AVERAGE(number 1, number2,…) 

Median MEDIAN(number1, number2, …) 

Mode MODE(number1, number2,… 

Standard Deviation  

 

Now let us calculate the statistics for the colour coefficient 

Quantity Control Data for Sharback Ventures 

 

 Unique manufacturing identification number (mfg ID#) 

 Size 

 Style 

 Date manufactured 

 Production line on which the Adire was manufactured 

 Colour coefficient value 

 Low texture 

 

To calculate the colour coefficient, the mean, median, mode and standard deviation are 

calculated for proper decision making. To achieve this, the following formulas are entered: 

 



 

For Mean - = AVERAGE(F2:F5)  

For Median - = MEDIAN(F2:F5)  

For MODE - = MODE(F2:F5) 

For STDEV   - = STDEV(F2:F5) 

 

The result showed there was no mode. The standard deviation would be best used for the 

decision. The present standard deviation would be compared with the previous standard 

deviation. The lower the standard deviation the better the coefficient. 

The use of excel in problem solving is not limited to manufacturing industry. It could be 

applicable to other industries such as education. Let‘s see how we can solve  the  following 

problem: 

 

 

The Problem: 

The above result was submitted by a lecturer. The examination officer is faced with the problem 

of providing the letter grades and thereby seeks an easy way this  can  be  achieved to meet the 

time line and at the same time minimize error. 

 

Question: What would the examination officer do to achieve this, using excel. 

 

Answer: To solve this problem, the examination officer has to use the ‗IF Formula‘,  if when 

defined will eliminate errors in the conversion of scores to letter grades and at the same time be 

fast enough to achieve the desired result. 

 

Procedure: 

1. Enter the data into excel worksheet and it will appear thus: 

 

S/N

O 

 

NAMES 

MATRIC 

NUMBER 

 

C.A

. 

EXAM 

SCORE 

 

TOTAL 

LETTER 

GRADE 

 

RMK 

1 Adeniji Eunice kemi 03/01/AV/01/053 19 27 46   

2 Adeoye Victor A. 03/01/AV/03/041 19 33 52   

3 Adesanya S. Adekunle 03/01/AV/01/010 19 27 46   

4 Adesuji Modupe Om 

oboja 

03/01/AV/01/054 19 27 46   

5 Adeyemi Ademola 03/01/AV/01/055 21 36 57   

6 Afolabi Motunrayo S. 03/01/AV/01/056 22 33 55   

7 Agbebaku Evelyn 03/01/AV/03/002 21 36 57   

8 Agoro Fadilat T. 03/01/AV/03/042 21 33 54   

9 Agunbiade Bukola 03/01/AV/01/140 21 29 50   

10 Ajayi Emmanuel O. 03/01/AV/01/011 19 27 46   



 

 

2. Place your cursor on G2 and type the following formula 

 

=IF(F2>69,"A",IF(F2>59,"B",IF(F2>49,"C",IF(F2>44,"D",IF(F2>39," E","F"))))) 

 

3. Press the enter key. The letter grade will appear thus: 

 

 
 

4. Copy the result in G2 into other cells. The result would be: 

 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Practice all that you have read so far with solving business problems with Microsoft 



 

excel. Share your experience with your co-students. 

2. Identify a problem in a particular organisation and use Microsoft Office Excel to solve 

the problem. Explain how you were able to achieve this. 

 

   5.0 Conclusion 

There are a lot of ways excel can be used to solve business problems. But first and foremost, you 

must identify the prevailing problem and know the possible ways of  solving that problem and 

then approach the possible solution. Where you do not  know  the right formula to use, go to the 

Help function of excel and study the recommended  ways each formula can be applied. You 

should always use the help function. 

 

    6.0 Summary 

For excel to effectively help in solving business problems, the user must be able to identify the 

problem areas and the possible solutions to the problem. After which the appropriate section of 

excel is applied. There is no limitation on the type of business excel can be used. Excel if 

properly applied can be useful in all kinds of business – manufacturing or servicing. 
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   1.0 Introduction 

Most people usually run into problem with dealing with large data. At a point it may become 

cumbersome managing data to derive desirable results. At this point in time it becomes necessary 

to look for alternative ways stress can be reduced in achieving the desired goal. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Freeze panes and split windows in excel 

 manage large data 

 

   3.0 Main Content 

3.1 Freezing Panes 

Freezing panes means making some rows and columns visible while you scroll across the work 

sheet. Large worksheets usually go beyond the window view at a time. In this instance the part 

that is required to supply leading information may be kept in view while other rows or columns 

scroll. 

 

In this excel sheet, the number of students go beyond 14. To see the other names would require 

scrolling the rows. But once the rows are scrolled, row 9 would no longer be visible because it 

would scroll up to give space to view the underneath names. But, the information in row 9 is 

guide to what data should be entered in each cell of the data. Therefore you may want to leave 

row 9 and column A on view while others scroll. To achieve this, the following steps should be 

adopted. 

 



 

Procedure: 

 

1. Place your cursor on B10 

2. On the view menu, click on Freeze Panes and you will have: 

 

3. Click on freeze panes 

Once this is done, as you scroll, column A and row 9 will be on view.  Originally, the   data that 

were on view were S/N 1 – 14.  With freezing of panes, as you scroll you will see more data but 

column A and row 9 constant. The table below shows the data after freezing and scrolling. You 

will observe that the new data on the screen view shows S/N 15 – 28 but with the headings still 

on view. 

 
 



 

You could also freeze only row or column instead of freezing both. It all  depends  on what 

you need at a time. 

 

3.2 Splitting Window 

Another way to manage large data is to split window. This is very helpful when you want to 

compare values. Let us consider the academic result of a set of students for academic year 2005 

and 2006. The data may be entered thus: 

 

To be able to scroll and compare, go to view menu, place your cursor in between the two sets of 

data or any other point as desired. The placement of the cursor would determine whether the 

sheet will split horizontally, vertically or both then go to ‗window group‘ in the view menu and 

click on ‗split‘.  

The resulting effect would be: 

 



 

This view presents two windows. You can scroll on both. 

Thirdly, large data could be managed by hiding the unwanted data at a time.  Supposing in the 

above data, you are only interested in printing the Matric. Number and the Grade Point (Letter 

Grade), but still want to retain the data in the database. You could take the following steps: 

 

Highlight the unwanted row, right click, and select ‗Hide‘. Repeat this for all unwanted rows and 

columns. At the end only the desired columns or rows would be left. See the example below: 

 

From the above, only columns A, C and G are on view, the other columns in between are 

hidden. To unhide, highlight the columns, right click and select ‗Unhide‘. 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Practice working on an excel worksheet with the above examples. Share your experience 

with your colleagues and facilitator. 

2. Present data involving large worksheet and explain how you where able to manage the 

data. 

 

   5.0 Conclusion 

In conclusion always identify the area of problem encountered in managing large worksheet. 

This would help you sort out the right solution to the problem using excel. 

 

    6.0 Summary 

There are three basic ways of managing large worksheets. It could be done through freezing of 

panes, splitting of window and hiding of rows and columns. The prevailing problem would 



 

determine the type that may be applied at a time. 
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   1.0 Introduction 

In the previous units, chart was discussed as an illustration device which enhances business 

documentation. This unit shall be more elaborate on how charts are used in presenting data, not 

just for illustration only. Data well presented in charts are easier to understand than those 

presented in elaborate texts and figures. Some people do not have the patience to read and 

deduce facts, thereby may run into wrong conclusion or ignoring the data. This is why in 

business, presentation of data in charts is encouraged. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 present data in charts for maximum interpretation 

 

   3.0 Main Content 

Before we go on problem solving, let us have a review on creating charts in excel. 

Creating Charts in Excel 

Step 1:  Enter the data for the chart in excel worksheet.  The type of chart to be used would 

determine how the data would be entered into the worksheet.  This would be discussed later. 

 

Step 2: Select the cells that contain the data for the chart. 

 

Step 3: On the Insert tab, in the Charts group, click the chart type as desired.  

Step 4: Follow the given instruction to complete the chart. 

To create charts in a way that will make them meaningful to your audience, you need to decide 

what exactly you want the audience to understand and the type of audience that is target because 

some charts are easier to understand than others. Knowing what you want will help you to select 



 

from the wide range of charts. 

 

Things to remember in the use of chart types are the types of charts and the arrangement of 

figures. The type of charts excel provided are: 

 

 Column charts 

 Line charts 

 Pie charts 

 Bar charts 

 Area charts 

 XY (Scatter) charts 

 Stock charts 

 Surface charts 

 Doughnut charts 

 Bubble charts 

 Radar charts 

Arrangement of Values in Charts 

 

The type of chart to be used determines the way the values would be entered into the 

worksheet. Let us briefly look at what should be noted when entering values into worksheet 

for a chart 

 

Column Charts – The categories are entered in the horizontal axis and the values are 

entered in the vertical axis. 

 

Line Charts – The categories are distributed evenly along horizontal axis, while the values 

are distributed evenly along the vertical axis. 

 

Pie Charts – shows size of items in one data series, proportional to the sum of the items. 

Data points are displayed as percentage of the whole pie.  Therefore in a  pie chart data  are 

arranged in one column or row only. 

 

Bar Charts – Illustrate comparison among individual items. Data are arranged in rows and 

columns. 

 

Area Charts – Data are arranged in rows and column of the worksheet.  For example, data 

that represent profit over time can be plotted in an area chart. 

 

XY (Scatter) Charts – Data is arranged in rows and columns. Scatter charts show the 



 

relationships among the numeric values in several data series, or plots two groups of 

numbers as one series of XY coordinates. In arranging data on a worksheet for a scatter 

chart, place the X value in one row or column, and then enter the corresponding Y value  in 

the adjacent rows or columns e.g. 

 

Days Weather Forecast Predicted Weather 

Forecast 

Monday 32
o
C 35

o
C 

Tuesday 36
o
C 38

o
C 

Wednesday 24
o
C 42

o
C 

Thursday 30
o
C 34

o
C 

 

 
X values   Y values 

 

Stock Charts – Data are arranged in columns and rows in a specific order on a worksheet. E.g. 

to create a simple high-low-close stock chart, you should arrange your data High, Low, and 

Close entered as Column Headings, see below: 

 

 

Date High Low Close 

2/09/09 58 53 55.5 

7/09/09 57 56 56.5 

11/09/09 52 50 51 

 

The sub-types of stock charts are: 

 

 High-Low-Close 

 Open-High-Low-Close 

 Volume-High-Low-Close 

 Volume-Open-High-Low-Close 

 

Surface Charts – These charts are useful when you want to find optimum combinations between 

two sets of data. As in topographic map, colours and patterns indicate areas that are in the same 

range of values. Data for surface charts is arranged in columns and rows on a worksheet. You 

can use surface chart when both categories and data series are numeric values. 

 

Doughnut Charts – Data are arranged in rows and columns only. A doughnut chart shows the 



 

relationship of parts to a whole, it can contain more than one data series. Doughnut charts are not 

easy to read. 

Bubble Charts – Data are arranged in columns on a worksheet.  The X values are listed in the 

first column and corresponding Y values and bubble size values are listed in the adjacent 

columns e.g. 

No of Products Sales (N) Market Share % 

15 21,500 3 

25 66,200 10 

20 23,000 5 

 

Radar Charts – Data are arranged in columns or rows on a worksheet. Radar charts compare the 

aggregate values of number of data series. 

 

You can equally create charts in other Microsoft office environment, such as Office Power Point 

2013 and Office Word 2013. The process of creation is the same as it is in excel. You can 

equally copy charts from excel to PowerPoint 2013 and Word 2013. 

 

Modifying Charts 

You can modify charts after they have been created. To modify charts, you can: 

 Change the display of chart axes 

 Add titles and data labels to a chart 

 Add legend or data table 

 

To make your chart eye-catching, you can format your chart to: 

 Fill chart elements. This will enable you use colour, textures, pictures and gradient fills 

 Change the outline of chart elements 

 Add special effects to chart elements 

 Format text and numbers 

For help, visit the ‗Help Function‘ in 2007 Microsoft Excel. 

 

Now let us see how we can present some data with the use of charts.  

Example 1: Present the following data with an appropriate chart. 

 

Enrolment in XYZ Primary School 

2005 2006 2007 2008 

Boys 234 244 342 234 

Girls 231 240 321 231 

Column or bar charts will be appropriate for this data. But for the purpose of this study, 

we shall use the column chart. To do this, follow the following procedure: 



 

 

1. Enter the data into a worksheet 

 

 

2. Select the cells that contain the data 

 

 

3. On the Insert tab, in the charts group, click the column chart type and select as desired 

 

 

4. A click on selected column chart will appear thus: 



 

 
 

5. Click outside the chart and re-click on it, left click without releasing your hand and move 

the chart to desired position. 

 

6. To add title, click on the chart, and select layout menu 

 

 

7. Click on chart title, and select as desired 



 

 
 

 

8. Type in the title of the chart in the box ―Chart Title‖. 

 

9. Click outside the chart, your chart is ready. 

 

 

10. You may want to remove the border. To remove the border, right click  on the  chart and  

from the drop down menu select ―format Chart Area‖, after selection  you will have: 



 

 
 

11. Select ‗Border Color‘, and click on ‗no line‘, then close. The resulting effect would 

be: 

 

 

 

12. You can remove the gridlines. To remove the gridlines, select click on the chart  and 

select ‗layout menu‘, then click on gridlines and select as desired.  The resulting effect would 

appear thus: 

 



 

 
 

You can get more effect as desired. 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Get as many data as you  can  and  present them in charts. You may work in group, or 

share your experience with your facilitator or colleagues at the completion of the task. 

2. Collect data from any form of business and present the data in: 

 

i. Pie chart 

ii. Bar chart 

iii. Bubble chart 

iv. XY (Scatter) chart 

 

   5.0 Conclusion 

There are various types of charts which can be used to present different types of data.  The kind 

of data to be presented would determine the type of chart that may be use. To have a desirable 

result chart data should be entered appropriately into the excel worksheet. 

 

    6.0 Summary 

There are eleven types of charts in excel. These include column charts, line charts, pie charts, bar 

charts, area charts, XY (scatter) charts, stock charts, surface charts, doughnut charts, bubble 

charts and radar charts. The type of data to be presented would determine the type of chart that 

should be used at a time. 
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Module 4: OTHER APPLICATIONS IN BUSINESS 

 

Module Introduction 

This module presents the use of various applications such as Microsoft access as a database tool, 

Paint for drawing/graphics, Microsoft outlook for messaging, keeping track of tasks, etc in 

business. This module is divided into four (4) units: 

Unit 1:  Graphics 

Unit 2:  Database 

Unit 3:  Microsoft Office Outlook 

Unit 4:  Desktop Tools/Data Communication/Creating Website 

 

Unit 1: Graphics 

 

Contents 

1.0 Introduction 

2.0 Intended Learning Outcomes (ILOs) 

3.5 Main Content 

4.0 Self-Assessment Exercise(s) 

5.0 Conclusion 

6.0 Summary 

7.0 Further Readings 

 

   1.0 Introduction 

Graphics are essentials in enriching business documents. There are major graphics that require 

special training, which is usually categorised under desktop publishing. However, in the day-to-

day business, one may not require major training. What are these graphics?  Computer graphics 

refer to any pictorial representation that can be produced by computer, either on the display, 

printer, plotter, or other output devices (Allen and Klooster, 1990). Graphics could be charts, 

diagrams or pictures. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Give examples of computer graphics 

 Describe the use of paint programs 

Comment [D7]: Updated the use of 
Microsoft access and Microsoft outlook 
2007 to 2010/2013. 
Updated the use of Paint in windows 
XP/7 to paint in windows 10  
Improved on the references and further 
readings. Expunged the very old 
references and incorporated recent 
references and books for further 
readings. 



 

 Solve business problems with simple computer aided graphic designs 

 

   3.0 Main Content 

There are different types of graphic software, some require special skills and others may 

easily be integrated into documents. The following are examples of graphic software: 

 

 Paint Programs – This allows the user to integrate arts into a document. 

 CAD programmes – This is used for computer-aided drafting and used to assist 

designers of products in drawing plan. CAD could be contrasted to paint. 

 Graphing programs – these include pie, charts, bar graphs etc. 

For the business of this course, the paint programme shall be discussed in details. But before we 

go on to discuss paint, it is important to know that computer graphics are used in every kind of 

business e.g. education, media, manufacturing companies, health etc. 

 

Paint 

Paint forms a good tool when you want to add special effect to your document e.g.  shapes, this 

can be duplicated, flip, rotate, tilt the image and as well perform other desired operations. 

To access paint, do the following: 

Method 1: Type paint in the search box on the taskbar, and then press Enter key to start Paint 

app. 

 
 

Method 2: Go to Start Menu and click All apps, you can find it under Windows 



 

Accessories folder. 

 
 

A click on paint would produce the following: 

 
 

Working under paint environment is very easy. All you need to understand know is the functions 

of each tool. To know what each tool does, place your cursor on a tool, do not click, and it would 

prompt the function e.g. 

 



 

 
 

This means the ―A‖ sign is a ―text‖ tool. A click on the text tool would give you a ‗+‘ sign. Draw 

a rectangle with the sign in the free space and type whatever you desire to type. As soon as  the  

rectangle shape is  drawn a  text  menu bar comes up. See the example below: 

 

 
 

While within the text box, you can format your text as desired using the text tools. Now 

let us discuss the function of the other tools: 

Type your 
text here 



 

 

 
The tools you will often require to do your work include select, eraser, text, line, pencil and pick 

colour or fill with colour. The select tool will enable you to move text or object from one position 

to another. To do this, click on select tool and draw a rectangle around the text or object, click 

and move to desired position.  For any of the tools you want to use, click on it and apply. 

 

 



 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Perform the following task with paint software: 

a. Type the words ―I love paint software‖. 

b. Draw this as it is 

c. Draw the following. You may use different colours. 

d. Share your experience with your colleagues. 

2. With reference to a particular business problem, present a typed work in which you 

combine Microsoft word and Paint. Explain how you achieved your task. 

   5.0 Conclusion 

The use of paint software helps to improve the effect on our documents. You can copy or cut text 

or object from paint environment to other environments such as word and excel. Other graphics 

software includes CorelDraw and Photoshops. 

 

    6.0 Summary 

Graphics help to enhance our business documents. There are different types of graphic software, 

but the one that can easily be learned is the paint software. Others may require more time to 



 

train. 

 

   7.0  Further Readings 

 

2013 Microsoft Office 

 

Bott, E., Siechert, C., & Stinson, C. (2016). Windows 10 inside out: Includes current book 

service. Redmond, WA: Microsoft. 

 

FrontPage: Microsoft Office. (2005). Barcelona: Ed. ENI. 

 

Gross D.,  Akaiwa F.,  Nordquist K. & Evans J. (2008). Business Computing Using Excel and FrontPage. 

U.S.A. Thomson Course Technology. 

 

Lambert, J., & Cox, J. (2013). Microsoft Outlook 2013: Step by Step. Redmond, WA: Microsoft. 

 

Matthews, M. S. (1996). Web publishing with Microsoft FrontPage. Berkeley, CA: Osborne 

McGraw-Hill. 

 

McFedries, P. (2015). Windows 10 simplified. Indianapolis, IN: John Wiley & Sons. 

 

Murray, K. (2013). Microsoft Office Professional 2013: Plain & Simple. Sebastopol, California 

:: OReilly Media. 

 

Pazmandy, G. (2013). Business computing: Using Microsoft® Office 2013. Rose Bay, NSW: 

Tekniks Publications. 

 

Price, M. (2013). Office 2013: In easy steps. Leamington Spa, Warwickshire, U.K.: In Easy 

Steps. 

 

Rathbone, A. (2018). Windows 10 for dummies. Milano: Hoepli. 

 

Weverka, P. (2013). Office 2013 all-in-one for dummies. Hoboken, NJ: John Wiley & Sons. 

 

 

 

 



 

Unit 2: Database 

 

Contents 

1.0 Introduction 

2.0 Intended Learning Outcomes (ILOs) 

3.6 Main Content 

4.0 Self-Assessment Exercise(s) 

5.0 Conclusion 

6.0 Summary 

7.0 Further Readings 

 

   1.0 Introduction 

A database is a collection of organised data with relationship in their elements. This can be 

achieved by using software usually referred to as database management system (DBMS). 

Database helps to maintain all relevant data in such a way that it will be useful  to its owner for 

record keeping and decision making. There are commercial database management soft wares, but 

apart from the commercially produced database management software, an organisation can have 

its own customised database software with the help of programmers to meet with the day-to-day 

running of the organisation. With the use of commercial database software, you will be able to 

enter data, manipulate data, and report information from the data without programming. These 

functions can be categorised as: 

 

 Creating the structure of database 

 Adding data to the database 

 Editing data already in the database 

 Retrieving data 

 Designing reports 

 Modifying the structure of the data base 

The type of computer and the brand of software used would determine how these functions are 

accessed by commands, by menu choices selected with the keyboard or by making selection with 

a mouse. 

 

The database software that shall be used for analysis in this unit is Microsoft Office Access 2007. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Identify a database 



 

 Solve business problems with Microsoft Office Access 

 

   3.0 Main Content 

Database is a collection of related information on a particular subject or purpose.  This may 

involve tracking customers orders. Information is usually not from one source. A database is 

formed when a collection of information is organised for quick and easy retrieval of needed 

information. Database started in paper-based, examples of  paper- based database are telephone 

directories and dictionaries. A database file  divides  data into separate storage containers called 

tables. You can view, add and update table data through online forms. 

 

This unit will be devoted more to solving business problems with Access. The basics of Access 

have been discussed in BED 211 – Microsoft Office. You should make reference to BED 211, 

and never forget to use the help function (just press F1 key) any time you need more assistance. 

But for the purpose of reminder the following table is presented. 

Table 1: General Preview 

 

Objects Functions 

Table To store data. Create a table for 

each information that you track. 

Query To find and retrieve data. Query can also

 be used for updating and 

deleting multiple records at the same 

time. 

Form A form helps you to view, enter and 

change data directly in a table. 

Report Report helps to analyse your data 

 and present it in the format for 

printing. 

Data Access Page This helps to make data available on 

the internet fro interactive reporting. 

Columns Columns in a table are called fields 

Rows Rows in a table are called records 

Table Datasheet View This enables you to add, edit, view 

and work with data in a table. 

 

Table 2: Working with formulas 

 



 

Function Description Use with the data 

type(s) 

 

 

Average 

Calculates the av erage val ue for a 

column. The col umn must 

contain numeric, currency, or 

date/time data. T he function 

ignores null values. 

 

Number, Currency, Date/Ti me 

 

 

Maximum 

Returns the item with the highest 

val ue. For text data, t he 

highest val ue is the last alphabetic value 

— Access i gnores case. 

 

Number, Currency, Date/Ti me 

 

 

Minimum 

Returns the item with the lowest value. 

For te xt data, the lowest value is the first 

alphabeti c value 

— Access i gnores case. The 

function ignores null values. 

 

Number, Currency, Date/Ti me 

Standard 

Deviation 

Measures how widely values are 

dispersed from an average val ue (a 

mean). 

 

Number, Currency 

 

Sum 

Adds the items in a column. 

Works only on numeric and 

currency data. 

 

Number, Currency 

 

 

Variance 

Measures the statistical variance of all 

values in the column. You can use this 

function only on numeric and currency 

data. If the table contains less than two 

rows, Access returns a null 

 

 

Number, Currency 

Source: Microsoft Offi ce Access 2013 

 

 

For the purpose of solving problems in business, let us look at the following: 

 

Working with Query 

 

Before you  start  have a table. To build a query, do the following as suggested by Microsoft 

Office Access 2013. 

 

1. On the Create tab, click Query Wizard. 



 

 

2. In the New Query dialog box, click Simple Query Wizard, and then click OK. 

 

3. Under Tables/Queries, click the table that has the data that you want to use. In this case, 

click Table: Customers. Note that a query can also use another query as a record source. 

4. Under Available Fields, double-click the Contact, Address, Phone, and City fields. 

This adds them to the Selected Fields list. When you have added all four fields, click Next. 

 

5. Name the query London Contacts, and then click Finish. 

Access displays all of the contact records in Datasheet view. The results show all of the records, 

but show only the four fields that you specified in the query wizard 

 

6. Close the query, and note that your query is automatically saved. 

 

Calculating Grand Totals Using Query 

 

In business transactions, there is often the need to calculate figures, which are used for decision 

making. Here are examples: 

 

The Order Table 

Order ID Order Date Ship Date Ship 

City 

Shipping Fee (N) 

1 11/8/2007 8/12/2007 Benin 1,000.00 

2 11/8/2007 8/12/2007 Kano 2,500.00 

3 8/15/2007 8/18/2007 Abuja 2,500.00 

4 8/20/2007 8/21/2007 Lagos 500.00 

5 8/20/2007 8/21/2007 Ibadan 800.00 

 

 

 

Order Details Table 

Detail ID Order ID Product Name Product ID Unit Price (N) Quantit y Discount 

1 1 Deep Freezer 12 11,800.95 4 0.05 

2 1 Desktop 1 70,000.25 3 0 

  Computer     

3 2 Horse Fan 3 15,000.75 9 0.03 

4 2 Giant Size Generator 5 62,875.00 12 0.04 



 

5 2 Laptops (Acer) 8‖ 8 68,699.00 11 0.06 

6 3 Microwave oven 9 12,375.00 4 0.09 

7 4 Typist Chair 10 868.00 8 0.08 

       

 

From the above tables, calculate: 

a. Simple grand total 

b. Calculate grand total that exclude some records 

 

To achieve this follow the following procedure as stated in Microsoft Office Access 2013: 

 

a. To calculate simple grand total, do this: 

 

i. On the Create tab, click Query Design. 

 

 
 

ii. In the Show Table dialog box, 

 
 

double-click the table that you want to use in your query, and then click Close. 



 

NOTE 

TIP 

 

 

If you use the sample data, double-click the Orders table. 

The table appears in a window in the upper section of the query designer. 

 

iii. Double-click the field that you want to sum. Make sure that the field is set to either the 

Number or Currency data type. If you try to sum values in non-numeric fields, such as a Text 

field, Access displays the Data type mismatch in criteria expression error message when you 

try to run the query. 

 

If you use the sample data, double-click the Shipping Fee column. 

You can add additional numeric fields to the grid if you want to calculate grand 

totals for those fields. A totals query can calculate grand totals for more than one column. 

 

iv. On the Design tab, in the Show/Hi de group, click Totals.  

The Total row appears in the design grid and Group By appears in the cell in the Shipping Fee 

column. 

 

v. Change the value in the cell in the Total row to Sum. 

 

vi. Click Run to run the query and display the results in Datasheet view. 

 

Note that Access appends "SumOf" to the beginning of the name of the field that you sum. 

To change the column heading to something more meaningful, such as Total Shipping, switch 

back to Design view, and click in the Field row of the Shipping Fee column in the design grid. 

Place the cursor next to Shipping Fee and type the words Total Shipping, followed by a colon, 

like so: Total Shipping: Shipping Fee. 



 

 

vii. Optionally, save the query and close it.  

 

b. To calculate a grand total that excludes some records. Do the following: 

 

1. On the Create tab, click Query Design. 

 

2. In the Show Table dialog box, double-click the Order table and Order Details table, and 

then click Close to close the dialog box. Then this appears: 

 
 

 

3. Add the Order Date field from the Orders table to the first column in the query design 

grid. 

 

4. In the Criteria row of the first column, type Date() -1. That expression excludes the 

current day's records from the calculated total. 

 

5. Next, create the column that calculates the sales amount for each transaction. Type the 

following expression in the Field row of the second column in the grid: 

 

Total Sales Value: (1-[Order Details].[Discount]/100)*([Or der Details].[Unit Price]*[Or 

der Details].[Quantity]) 

Make sure your expression references fields set to the Number or Currency data types. If your 

expression refers to fields set to other data types, Access displays the message Data type 

mismatch in criteria expression when you try to run the query. 

 

6. On the Design tab, in the Show/Hi de group, click Totals. 

The Total row appears in the design grid and Group By appears in the first and second columns. 

 

7. In the second column, change the value in the cell of the Total row to Sum. The 



 

NOTE 

Sum function adds the individual sales figures. 

 

8. Click Run to run the query and display the results in Datasheet view. 

9. Save the query as Daily Sales. 

The next time that you open the query in Design view, you might notice a slight 

change in the values specified in the Field and Total rows of the Total Sales Value 

column. The expression appears enclosed inside the Sum function, and the Total row 

displays Expression instead of Sum. 

 

For example, if you use the sample data and create the query (as shown in the previous steps), 

you see: 

 

Total Sales Value: Sum((1-[Order Details].Discount/100)*([Or der Details].Unitprice*[Or 

der Details]. Quantity)) 

The use of Microsoft Access is not restricted to buying and selling, it could equally be used in 

educational institutions. Access enhance student database. 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Practice the examples given above and share your experience with your colleagues. 

 

Students' Data 

 

S/N 

 

Surname 

 

First Name 

 

School 

 

State of Origin 

1 Adegoke Judith Education Ondo 

 

2 

 

Okonofua 

 

Otihbor 

Arts and Social 

Sciences 

 

Edo 

3 Okoro John Law Aba 

4 Adeboye Caroline Education Oyo 

5 Ujagbe Mary Law Edo 

6 Abanikannda Adegoke Business Lagos 

7 Amekhiena Maria Business Edo 

8 Oyakhilome Ebi Education Ondo 

 

9 

 

Okoruwa 

 

Ani 

Arts and Social 

Sciences 

 

Delta 

 

10 

 

Abraihim 

 

Adako 

Arts and Social 

Sciences 

 

Kano 

 

 



 

Examination Scores for 2007 

 

 

S/N 

 

 

 

Surname 

 

 

First 

Name 

 

 

 

School 

 

 

 

Program 

 

 

 

Level 

 

 

 

Course 

 

Exam 

Scores 

(100%) 

 

1 

 

Adegoke 

 

Judith 

 

Education 

Business 

Education 

 

100 

 

BED 112 

 

40 

 

 

2 

 

 

Okonofua 

 

 

Otihbor 

Arts and 

Social 

Sciences 

 

 

Theology 

 

 

300 

 

 

TH 321 

 

 

50 

3 Okoro John Law Criminal Law 200 LAW 223 55 

 

4 

 

Adeboye 

 

Caroline 

 

Education 

Primary 

Education 

 

100 

 

PRI 134 

 

66 

 

5 

 

Ujagbe 

 

Mary 

 

Law 

 

Civil Law 

 

200 

LAW 

222 

 

65 

 

6 

 

Abanikannda 

 

Adegoke 

 

Business 

Entrepreneu 

rship 

 

300 

BHM 

342 

 

56 

 

7 

 

Amekhiena 

 

Maria 

 

Business 

Banking and 

Finance 

 

300 

BHM 

223 

 

67 

 

8 

 

Oyakhilome 

 

Ebi 

 

Education 

Business 

Education 

 

200 

EDU 

223 

 

55 

 

 

9 

 

 

Okoruwa 

 

 

Ani 

Arts and 

Social 

Sciences 

 

 

French 

 

 

100 

 

 

FRE 111 

 

 

68 

 

 

10 

 

 

Abraihim 

 

 

Adako 

Arts and 

Social 

Sciences 

 

 

English 

 

 

200 

 

ENG 

221 

 

 

67 

 

i. Prepare a database for the above data in the tables 

ii. Show the results of serial numbers 2,3,5,6, and 10 with other details of the students 

 

 

   5.0 Conclusion 

Database software enhances decision making in business especially in critical times of solving 

problems. But correct data need to be fed into the database so as to be able to get accurate 

information that would be required for decision making. 

 



 

    6.0 Summary 

There are different types of database software. Some are commercially produced while some are 

customised. To have a customised software requires a programmer who will programme what is 

required in the organisation. 
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   1.0 Introduction 

Microsoft Office Outlook is very useful in office management. It has four major areas where its 

value is very essential in business. These include mail, calendar, contacts and tasks. Though the 

basics of this software has been taught in BED 211 – Microsoft Office,  a review of it shall be 

made in this unit, while the main focus would be on solving business problems using Microsoft 

Office Outlook 2013. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Organise meetings effectively using Microsoft Office Outlook 

 Monitor tasks adequately using Microsoft Office Outlook 

 

   3.0 Main Content 

Microsoft Office Outlook 2013 as earlier mentioned has four major features – calendar, contacts, 

tasks and mail. We shall discuss these briefly and apply them to some problems that may often 

arise in business. 

 

With calendar, you can: 

 

 Create appointments and events – This can be achieved just the same way you write in 

a notebook, click anytime slot in the outlook calendar and begin typing. The current time is 

highlighted in colour. You could have message reminder of meetings, appointments, and events. 

You can easily colour items for quick identification. 

 View group schedules – With calendar you can show the schedules of a group of people 

or resources simultaneously. For instance you can view  the schedules of  all the persons in your 



 

department or other units. 

 Organi se meetings – to organise a meeting, select calendar and create a meeting request. 

 View Calendars Side by Side – Different Calendars created by you can  be  viewed side-

by-side and at the same time calendars shared by other outlook users. Appointments can also be 

copied and moved between the displayed calendars. 

 View Calendars on top of each other in overlay view – This display multiple calendars 

that you have created as well as calendar shared by other outlook users. 

 Manage another user’s calendar – You can manage another person‘s calendar with the 

use of Delegate Access feature. For example an administrative assistant can manage the calendar 

of a manager or his boss. 

With Contacts you can create contacts from within contacts, from an e-mail message that you 

receive and from electronic Business Cards that you receive. 

 

Tasks – To create a task the following are applicable: 

 

 To create and track assigned tasks – after you have completed a task and assign to some 

one, you may still need to manage it. For example, you might need status report and 

updates of the task in progress. 

 

To assign a task, first create the task, and send it as task request to someone. The person 

can decline the task, accept the task or assign the task  to  someone else.  The task is 

returned to you if it is declined, but even when the declined task is returned to you, it is 

still owned by the recipient until you reclaim ownership by returning the task to your own 

task list. 

 

But if you assign a task to more than one person at a time, you would not be able  to keep 

an update copy of that task in your task list. 

 

 To assign a task to someone the following steps are suggested by Microsoft Office 2013: 

1. To assign a new task, do the following: 

Step 1: Get into the Task Window and edit a new task. 

You can click the Home > New Items > Task to get into the Task Window in Outlook 2013. 

Step 2: Click the Assign Task button in the Manage Task group under the Task tab in the 

Ribbon. 



 

 
 

Step 3: Then the From box, To box and Send button appear above the Subject box. Just type 

names or email address in the To box. 

 
 

Step 4: Click the Send button, and this new built task is assigned to the people whose email 

addresses you typed in the To box. 

 

2. To assign existing task, do the following:  

 Go to the task list 

 Open the desired task 

 On the Task tab in the manage Task group, click Assign Task 

 In the box ‗To‘, enter the name or e-mail address of the person to whom you want to 

assign the task. 

 



 

 Type the name of the task in the subject box. For an existing task, the subject box is 

already filled in except you want to change. 

 

 Select the due date and status options as desired. 

 

 Select or clear the keep an updated copy of this task on my task list check box and the 

send me a status report when this task is complete check box. 

 

 To repeat the task, on the Task tab in the options group, click Recurrence, select desired 

options and click ok. 

 

 In the body of the recurring task, type any information you want to include in the task. 

 

 Click send. 

 

To forward a task to someone else to track, do the following: 

1. Open the task you want to send 

2. On the Task tab, in the manage Task group, click forward 

3. Enter recipient names or e-mail addresses in the, ―to‖ and ―cc‖, boxes 

4. Type the message at the body of the task 

5. Click send 

 

To reclaim a rejected test management, do the following: 

1. Open the e-mail message that contains the task request, which you will find in Sent item 

Folder. 

2. On the Task tab, in the manage Task group, click Return to Task list. Task can also be 

reclaimed from the declined task message by clicking Return to Task List. 

 

To track tasks that you have assigned, do the following: 

Automatically copies of the tasks assigned are kept and you receive automatic status 

reports. 

1. On the tools menu, click options 

2. Click Task Options 

3. Select the keep updated copies of assigned tasks on my task list check box 

4. Select the send status reports when assigned tasks are completed check box 

 

To view Tasks Assigned to others, do the following: 

1. Click Tasks 

2. On the View Menu, point to Current View and then click Assignment 



 

 

To view the list of people who received updated copies of an assigned task, do the following: 

1. Open the assigned task you want to view the list 

2. From the Details tab, view the names in the Update list box 

 

To Accept or decline a task assignment, do the following: 

1. Open the task or task request 

2. On the Task tab, in the manage Task group, click Accept or Decline 

3. Then: 

a. Click edit the response before sending, type your comment in the message and click send. 

b. Click send the response now 

 

To send a status report or a comment about a task assign ment, do the following: 

1. Open the task for which you want to send a status report or comment 

2. On the Task Tab, in the Manage Task group, click either Send Status Report, Reply or 

Reply to All 

3. Enter recipient names or e-mail addresses in the To and cc boxes 

4. Type any information that you want to include at the status report in the body of the 

message 

5. Click send 

 

To create an e-mail message, do the following: 

This is the most frequent task that is performed in Microsoft Office Outlook. Follow the process 

of creating the usual e-mail. Click on the e-mail option and follow the display on the menu. 

 

To set the delivery Options: 

Setting message in the order of importance enables the recipients to sort their message important. 

To do this,  go to  the  message Tab in the option group, click   High Importance or  Low 

Importance. 

 

To set message expiring date, do the following: 

1. On the option tab, in the more options group, click the message Options group, click the 

message options Dialog Box Launcher 

2. In the Message Options dialog box, under Delivery Options, select the Expires after 

checkbox and click a date or time. 

In Delay Sending a Message, do the following: 

1. On the options tab, in the More Options group, click delivery 

2. Click delivery date and time that you desire 

 

 



 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. Company XYZ has it‘s headquarters office at Abuja but with branches in the 36 states of 

the country Nigeria. The company runs a central administration from the headquarters at 

Abuja. The Head of Administration has new tasks to assign to all heads of units at the 

various branches which must be accomplished within one week of assignment. He has the 

following information to pass across. 

 

S/N Head of 

Unit 

e-mail Address Branch Message Start Date 

of Task 

1 Mr. K.O. 

Akaka 

oakaka@xyz.com   

 

To send the update of all 

transactions within the last four 

months to the headquarter on or 

before 7
th

 October, 2020 

 

 

 

1/10/2020 

2 Mr. E. B. 

Adeboye 

badeboye@xyz.com Ibadan 

3 Mrs. H. E. 

Ikejama 

eikejama@xyz.com Benin 

4 Ms. K. K. 

Udoh 

kudoh@xyz.com Warri 

5 Mr. Ada 

Ada 

aada@xyz.com Lagos   

6 Mr. J. K. 

Okouwa 

kokouwa@xyz.com Minna   

7 Mr. J. J. 

Johnson 

jjohnson@xyz.com Zaira   

 

From the above information and with the use of Microsoft Office Outlook, 

 

a. Assign task to heads of units 

b. Forward the task to the head of units in the specified branches 

c. Track the assigned task to head of units 

d. Send a status report on the assigned task 

2. With reference to a particular business, identify the problem areas that require the use of 

Microsoft Office Outlook. Explain how Microsoft Office Outlook can be used to  solve 

the problems. 

   5.0 Conclusion 

The use of Microsoft Office Outlook enhances communication within an office. It could be used 

to replace paper memoranda. 

mailto:oakaka@xyz.com
mailto:badeboye@xyz.com
mailto:eikejama@xyz.com
mailto:kudoh@xyz.com
mailto:aada@xyz.com
mailto:kokouwa@xyz.com
mailto:jjohnson@xyz.com


 

 

    6.0 Summary 

Microsoft Office Outlook 2007 covers the management of mail, calendars, contacts and tasks; 

which are basic requirements for the smooth running of any type of business. Go through the 

steps above to ensure adequate usage of Outlook. 
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   1.0 Introduction 

We have discussed some major software that enhance business transactions, such software 

Microsoft Office Word, Microsoft Office Excel, Microsoft Office Access and Microsoft Office 

Outlook. In this unit, we shall discuss other features, though not very major are essential in 

electronic office administration. This includes Desktop tools, Data Communication and creating 

website. 

 

   2.0 Intended Learning Outcomes (ILOs) 

At the end of this unit you should be able to: 

 Apply simple desktop tools in solving business problems with ease 

 Choose adequate communication hardware and software to solve diverse business 

problems 

 Direct the basics of web creation 

 

   3.0 Main Content 

The three main areas of concentration in the desktop tools in this unit shall be ‗the Address 

Book‘, ‗Calculator‘ and ‗Notepad‘. But the address book shall be discussed in details. The 

address book provides convenient way storing important information about people; finding 

business partners; creating contact; sending and receiving business cards electronically. The 

calculator is simplified for any user to be able to solve simple mathematical challenges and the 

notepad is designed for easy typing of data. To launch these tools; click start, point to 

programmes, point to accessories and click on the desired tool. 

 

Storing Contact 

There are different ways of adding contact to address book. These shall be discussed as detailed 



 

by the package (See Help Function in Address Book). 

To add names directly from e-mail messages to your Address Book, 

You can set up Outlook Express so that when you reply to a message, the people you reply to are 

automatically added to your Address Book. In addition, any time you send or receive a message 

in Outlook Express, you can add the recipient's or sender's name to your Address Book. 

 

To add all replies recipients to your Address Book 

1. In Outlook Express, on the Tools menu, click Options. 

2. On the Send tab, click Automatically put people I reply to in my Address Book. To 

add an individual name to your Address Book from Outlook Express 

 In a message you are viewing or replying to, right-click the person's name, and 

then click Add to Address Book. 

 In the message list of your Inbox or other mail folder, right-click a message, and 

then click Add Sender to Address Book. 

 

To import an address book from another program 

You can import address book contacts from other Windows Address Book files (.wab), as well 

as from Netscape Communicator, Microsoft Exchange Personal Address Book, or any text (.csv) 

file. 

 

For Windows Address Book files: 

1. In Address Book, on the File menu, point to Import, and then click Address Book 

(WAB). 

2. Locate and select the address book you want to import, and then click Open.  

 

For all other address book formats: 

1. In the Address Book, on the File menu, point to Import, and then click Other Address 

Books. 

2. Click the address book or file type you want to import, and then click Import. 

 

If your address book is not listed, you can export it to either a text (.csv) file or an LDIF (LDAP 

Directory Interchange Format) file, and then import it using that file type. 

 

To add a contact to your Address Book 

1. On the Outlook Express toolbar, click Tools, and then click Address Book. 

2. In the Address Book, select the folder to which you want to add a contact. 

3. On the Address Book toolbar, click New, and then click New Contact. 

4. On the Name tab, type at least the first and last name of the contact. This is the display 

name. 

 



 

A display name is required for each contact. If you enter a first, middle, or last name, it 

will automatically appear in the Display box. You can change the display name by typing 

in a different name or by selecting from the drop-down list. The drop-down list will 

contain variations of the first, middle, and last name, as well as anything you typed in the 

Nickname box or the Company box on the Business tab. 

5. On each of the other tabs, add any information you would like to include. 

 

Notes 

 

 Be sure to include an e-mail address for your contact. While your Address Book can be 

used for many purposes, its most immediate benefit is in providing e-mail addresses 

when you are composing mail. 

 If you include a contact's street address on the Home tab or the Business tab, you can 

click View Map located on each of these tabs to  display a  printable street map showing 

the contact's address. 

 

To find people and businesses on the Internet 

1. In the Address Book, click Find People on the toolbar. 

2. From the Look in drop-down list, select the directory you want to search. 

3. On the People tab, type the name or e-mail address of the person you want to look for, 

and then click Find Now. 

-or- 

 

On the Advanced tab, define the search criteria you want by filling in the top three  boxes, and 

then click Add.  Add all the search criteria you want, and then click Find Now. (To remove a 

search criterion you added, select the item you want to delete from the Define Criteria list, and 

then click Remove. Or, if you want to delete all criteria and start over, click Clear All.) 

 

Notes 

 Your search will be most efficient if you use starts with or is. The options for contains, 

ends with, or sounds like can make your search take  much  longer, possibly so long that 

the search fails. The more exact your search criteria, the faster the result. 

 If your search is too broad, the number of matches might exceed the limits of the server, 

or your directory service settings might not be set up to handle all of the returned 

matches. You can change these directory service settings. 

 

To import a business card 

1. In the Address Book, on the File menu, point to Import, and then click Business Card 

(vCard). 

2. Locate the business card file on your computer or a network drive, select it, and then 



 

click Open. 

Note 

 When the business card is added to your Address Book, a dialog box appears where you 

can modify or add to the contact information as necessary. 

 Once the contact's street address is entered on the Business tab, you can click the tab's 

View Map button to display a map pinpointing the address. When you click View Maps, 

Expedia Maps opens in your browser with a printable street map showing the contact's 

address. 

 

To change contact information 

 

 In the Address Book list, locate and double-click the name you want, and then change the 

information as needed. Click the tabs to access different information sections. 

 

Note 

 

 To delete a contact, select the contact name in the Address Book list, and  then  click 

Delete on the toolbar. If the contact is a member of a group, the name will also be 

removed from the group. 

 

To create a group of contacts 

You can create a single group name (or alias) to use when sending a message to several contacts 

at once. Simply create a group name and add individual contacts to the group. Then, just type the 

group name in the To box when you send e-mail. 

 

1. In the Address Book, select the folder in which you want to create a group. Click New on 

the toolbar, and then click New Group. 

2. The Properties dialog box opens. In the Group Name box, type the name of the group. 

3. There are several ways to add people to the group: 

 To add a person from your Address Book list, click Select Members, and then 

click a name from the Address Book list. 

 To add a person directly to the group without adding the name to your Address 

Book, type the person's name and e-mail address in the lower half of the 

Properties dialog box, and then click Add. 

 To add a person to both the group and your Address Book, click New Contact and 

fill in the appropriate information. 

 To use a directory service, click Select Members, and then click Find. Select a 

directory service from the drop-down list at the end of the text box. After finding 

and selecting an address, it is automatically added to your Address Book. 

4. Repeat for each addition until your group is defined. 



 

Note 

 To view a list of your groups separately from the Address Book listings, in the Address 

Book, on the View menu, make sure that Folders and Groups is selected. 

 You can create multiple groups, and contacts can belong to more than one group. 

 

To add a contact to an existing group 

1. In the Address Book list, double-click the group you want. The group's Properties dialog 

box opens. 

2. You can add people to the group in several ways —and in some cases you can add them 

to your Address Book as well. 

 To add a person from your Address Book list, click Select Members, and then 

click a name from the Address Book list. Click Select, and then click OK. 

 To use a directory service (use the drop-down list at the end of the text box to see 

directories you have added to Outlook Express), click Select Members, and then 

click Find. Select a directory service to search, enter your search criteria, and 

when you find the person, click Select, and then click OK. This 

person's name and e-mail address is added to your Address Book. 

 To add a person directly to the group without adding the name to your Address 

Book, type the person's name and e-mail address in the boxes provided in the 

lower half of the dialog box, and then click Add. 

 To add a person to both the group and your Address Book, click New Contact, fill 

in the appropriate information, and click OK. 

 

To create a business card 

 

The easiest way to exchange contact information with people over the Internet is by attaching a 

business card to e-mail messages. A business card is your contact information from the Address 

Book in vCard format. The vCard format can be used with a wide variety of digital devices and 

operating systems. 

 

You must have your contact information in your Address Book before you can create a business 

card. 

 

1. In the Address Book, create an entry for yourself, and then select your name from the 

Address Book list. 

2. On the File menu, point to Export, and then click Business Card (vCard). 

3. Select a location in which to store the file, and then click Save. 

 

Note 

 To add your business card to an e-mail message, on the Insert menu, click My Business 



 

Card. 

 

To add a contact's digital ID to your Address Book 

To send someone encrypted mail, you must have the recipient's digital ID, and that ID must be 

associated with the recipient's name in your Address Book. Outlook Express automatically adds 

digital IDs to your Address Book when you receive digitally signed mail. If you have turned off 

this option, you will need to manually add a contact's digital ID. 

 

1. Open the digitally signed message. 

2. On the File menu, click Properties. 

3. Click the Security tab, and then click Add digital ID to the address book. 

When a contact has a digital ID, a red ribbon is added to their card in your Address Book. 

 

To add a digital ID to your Address Book from another source 

 

1. In the Address Book, create a new entry for the contact, or double-click an existing one in 

the Address Book list. 

2. On the Digital IDs tab, click Import. 

3. Find the digital ID file, and then click Open. 

 

Notes 

 To automatically add a contact's digital ID to your Address Book, on the Tools menu, 

click Options. Then on the Security tab, click Advanced, and select Add senders' 

certificates to my address book. 

 You can also get someone's digital ID by downloading it from a certification authority's 

Web site. (See the Microsoft Internet Explorer Digital ID site for links to certification 

authorities.) 

 

To organize names in your Address Book 

When you have a large Address Book, you can organize it in several ways to make it easy to 

retrieve contacts and groups. 

 

 To sort contacts by name, e-mail address, or phone number, click the appropriate column 

heading above the name list. 

 To switch columns between ascending and descending sort order, click the column 

heading. 

 To change the order of the columns, point to a column heading (Name, E-mail Address, 

Home Phone, and so on), and then drag the column to the left or right until it's located 

where you want it. 

 To view a list of your mailing groups, on the View menu, select Folders and Groups. 



 

 

What are identities? 

 

Creating identities is a way for several people to use Outlook Express and the Address Book on 

the same computer. For example, you and a family member may share a computer. If you each 

create an identity, you would each see your own mail and  your  own contacts when you log on 

under your identity. Once your identity is created, you can organize your contacts the way you 

want them by creating subfolders. 

 

Usually, you will create identities while you are using Outlook Express (or other applications 

that use identities). You can create identities from your Address Book only when you open your 

Address Book from the Start menu rather than from Outlook Express. To open Address Book 

from the  Start  menu,  click  Start,  point  to  All Programs, point to Accessories, and then 

click Address Book. 

 

Organizing contacts and folders 

 

You can keep contacts in your main folder, as well as organize them into subfolders. If you have 

contacts you would like to share with the other people with whom you share Outlook Express, 

you can move contacts into the Shared Contact's folder, where other identities can view them 

when they use the Address Book. Subfolders are always in alphabetical order; you cannot 

reorganize them. 

 

If you cannot see the folders on the left, point to the View menu and select Folders and Groups. 

 

Deleting contacts from your Address Book 

You can easily remove contacts and groups from your Address Book. When you delete a contact 

from a group, the name is removed from the group but the entries for both the group and the 

individual remain in your Address Book. Likewise, deleting an  entire group does not remove the 

entries for the individual members who made up the group. 

 

 

To print Address Book information 

 

1. In the Address Book, select the contacts you want to print. 

 To select a block of names, press and hold down the SHIFT key, click the first 

name in the block and then click the last name in the block. 

 To select individual names, press and hold down the CTRL key while you click 

the names. 

2. Click Print on the toolbar. On the Print dialog box, under Print Style, select a printing 



 

style: 

 To print all Address Book information about the contacts, click Memo. 

 To print business-related information about the contacts, click Business Card. 

 To print a list of phone numbers for the selected contacts, click Phone List.  

Note 

 You may be able to customize the size and orientation of your printed Address Book 

pages. To view your printer's options, in the Print dialog box, click Properties. 

 

Finding People using Directory Service  

What are directory services? 

A directory service is a powerful search tool that you can use to find people and businesses 

around the world. The Address Book supports LDAP (Lightweight Directory Access Protocol) 

for accessing directory services, and it comes with built-in access to several popular directory 

services. You can also add additional directory services from your Internet service provider. 

 

Like the Internet search tools, directory services use different methods for collecting data, so 

when you are trying to find people or businesses online, you might try more than one service. 

 

To add a directory service 

 

To add a directory service to your Address Book, you will need the name of the computer server 

(available from the directory service provider). 

 

1. In either the Address Book or Outlook Express, on the Tools menu, click Accounts. 

2. In Outlook Express, select the Directory Service tab, click Add, click Directory 

Service, and then follow the instructions in the Internet Connection Wizard. 

In the Address Book, click Add, and follow the instructions in the Internet Connection 

Wizard 

 

To find people and businesses on the Internet 

 

1. In the Address Book, click Find People on the toolbar. 

2. From the Look in drop-down list, select the directory you want to search. 

3. On the People tab, type the name or e-mail address of the person you  want to look  for, 

and then click Find Now. 

-or- 

On the Advanced tab, define the search criteria you want by filling in the top three boxes, and 

then click Add. Add all the search criteria you want, and then click Find Now. (To remove a 

search criterion you added, select the item you want to delete from the Define Criteria list, and 

then click Remove. Or, if you want to delete all criteria and start all over, click Clear All.) 



 

 

Notes 

 Your search will be most efficient if you use starts with or is. The options for contains, 

ends with, or sounds like can make your search take much longer, possibly so long that 

the search fails. The more exact your search criteria, the faster the result. 

 If your search is too broad, the number of matches might exceed the limits of the server, 

or your directory service settings might not be set up to handle all of the returned 

matches. You can change these directory service settings. 

 

To set up a directory service to check for e-mail addresses 

When you can't remember someone's complete e-mail address, you can enter a partial name and 

then use the Check Names command on the Tools menu to search for matches. Outlook Express 

first searches your Address Book and if no matches are found, searches the directory services 

you have set up to check e-mail addresses. 

 

1. In the Address Book or Outlook Express, on the Tools menu, click Accounts. 

2. If you are in Outlook Express, click the Directory Service tab. 

3. Select a directory service, and then click Properties. 

4. On the General tab, select the Check names against this server when sending  mail 

 

Using Your Address Book with other Programmes 

 

To export your Address Book contacts to other programs 

You can export your Address Book contacts to other Windows Address Book (.wab) files, as 

well as to Microsoft Exchange Personal Address Book, or any text (.csv) file. 

 

To export your Address Book files to another Windows Address Book: 

1. In Address Book, on the File  menu, point to  Export, and  then  click Address Book 

(WAB). 

2. Locate and select the Windows Address Book file you want to export to, and then click 

Open. 

For all other address book formats: 

1. In the Address Book, on the File menu, point to Export, and then click Other Address 

Book. 

2. Click the address book or file type you want to export to, and then click Export. 

 

To set up a conference call from the Address Book 

If you use Microsoft NetMeeting or other conferencing software, you can store conferencing 

account information (such as e-mail and server addresses) along with other contact information 

and then make a conferencing call directly from the Address Book. 



 

 

1. In the Address Book, double-click the contact name. 

2. On the NetMeeting tab, type the Conferencing Server address. (If NetMeeting is not 

installed, this tab is named Conferencing). 

3. Type the Conferencing Address for the contact. This address must be the one used for 

conferencing, which could be different from  the  contact's e-mail address. 

4. Click Add to add this information to the contact's properties. 

Now, whenever you want to initiate a conference call, you can click Call Now on the 

NetMeeting (or Conferencing) tab of the contact's properties. 

 

Note 

 You can have multiple e-mail addresses and directory servers listed for one contact. 

 

Communication 

No business can function without communication. Data communication is achieved by using 

communication hardware, software and transmission carriers. Computers that are connected to 

communicate with each other are referred to as ‗being network.‘ 

 

Advantages of Data Communication 

A good data communication leads to the following advantages: 

 More individuals have access to available hard and software 

 Expensive equipment can be shared 

 Data can be shared among users 

 Many tasks can be completed more conveniently and effectively 

 

Disadvantages of Data Communication 

Apart from the advantages associated with the use of data communication, there are equally 

disadvantages as stated below: 

 

 There would be no work once the mainframe computer goes down 

 High cost for backup systems and maintenance 

 Cost for transmission carriers can be high 

 Needs high trained and experienced personnel 

 Problem of incompatibility among hardware and software that may highly arise 

 

Uses of Communication Hard and Software 

1. Bulletin  Board  Systems: This involves sharing and exchanging ideas and 

information, which could come in: 

a. Electronic mail 

b. General messages and announcements 



 

c. File library that the user can download 

2. Information Services: The area of information services include: 

a. Local and national news 

b. Weather 

c. Travel 

d. Recipes 

e. Shopping 

3. Bibliographic Services: This is connected with library, and is as used in the library. 

4. Stock Exchange Services: This includes: 

a. Comprehensive company profile as per investors, earning forecast, price/volume, 

charts, financial history 

b. Up-to-date stock prices and quotes 

c. Individual customer portfolio management 

5. Electronic banking and transfer of funds 

 

Creating a Web Site 

It is advisable to have basic ideas about web site creation. You are not required to be an expert. 

With the advent of electronic marketing, you may be required to customise your company‘s web 

site. 

To develop a web site requires the creation of a team. The team includes: 

1. Graphic designers – they develop the visual appearance and create graphic images of the 

site. 

2. Marketing representative – Sets the goals for the web side and controls the presence of 

the organisation. 

3. Content developer and editor – prepares and evaluates the content. 

4. Director – This could also be referred to as webmaster. He co-ordinates teams‘ activities 

and at the same time manages web development. 

5. Programmer – Creates HTML documents and develops server processing. 

6. Systems administrator – Conversant with web server limitations, manages security and 

access and maintains system hardware. 

 

Developing a website involves the following activities: 

 Define the goal and purpose of the web site. This will include: 

o Primary intent 

o Short and long-term goals 

o Intended audience 

o Website plan – objectives, requirements and results. 

 Determine and prepare the web site‘s content. After the plan, the next stage is to develop 

the website content (gather relevant documents), you may re-visit the planning team for 

information. 



 

 Designing the website. This may include: 

o Working with the organisation objectives 

o Preparing a sitemap 

o Building the site 

 FrontPage is used to build and create a web site 

 In building and creating web site, you need to: 

o Determine the number of page web site 

o Specify the browser version 

o Specify the page size 

o Text in web page – to determine the type of text a web page should have you need 

to: 

 Determine the format 

 Proofread the content 

o Language used – The common language used is Hypertext Markup Language (HTML), 

which can be viewed with the use of FrontPage. 

 

 

4.0  4.0 Self-Assessment Exercise(s) 

Answer the following questions:  

1. With the aid of the above illustrations, organise your Address Book. Share your 

experience with your colleagues. 

2. With reference to a particular organisation, explain how Address Book would help the 

business achieve its goal. Demonstrate the process. 

 

   5.0 Conclusion 

In conclusion, it should be noted that there is no business that will be able to achieve a desired 

goal in this technological age without effective use of the computer in the administration of the 

business. A good use of the computer application leads to effectiveness and efficiency in 

business. 

 

    6.0 Summary 

In this unit, we have discussed elaborately, the use of Address Book. But we should not forget 

the use of calculator and Notepad. The Notepad can be likened to a note pad used  in long hand. 

Microsoft Power Point was not discussed in this course because it has been fully taught in BED 

211. But for the purpose of completeness, PowerPoint is very essential during presentation, 

especially when you want to have a demonstration of your product. All the required effect can 

always be added for the purpose of illustrations. 
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